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0B1.ネットワークに関する諸概念 
 
 ネットワークとは、頂点（ノード）の部分集合とラインの部分集合の 2 つの集合により

成り立っている。頂点の部分集合をユニット（Unit）、ラインの部分集合をユニット間の関

係（Relations）という。それらは、グラフという。 
ラインは、有向と無向に分けられる。頂点やラインの追加的な情報は属性として付属し

ている。（例：名前、ラベル、タイプ、値など）[11] 
 
 ネットワークは以下のように表される。 

),,,( WPLVN =  
グラフ ),( LVg = 、V は頂点の集合、 Aは有向線の集合、 Eは無向線の集合、 Lはライン

の集合で AEL ∪= 。 )(Vcardn = （card は要素） )(Lcardm = 。 
P頂点の値関数/ 属性： →Vp :  A（有向線集合 Aとは違う） 
W ラインの値関数/ 重さ： BLw →:  
 
グラフ(Graph)について 
Actor（アクター）：頂点、ノード 
Relation（関係）：ライン、無向線、有向線、リンク、タイ 

 
arc（a,d）に注目すると、a は initial vertex,d は terminal vertex という。 
edge（c:d）に注目すると、c と d は end vertex という。 
i のように、どの頂点ともつながっていない頂点のことを isolated vertex という。 
c の頂点にある自分から出発して自分に帰るラインのことを Loop という。 
以下のようなものもある。 

a 
b 

c 

e 
f 

d 

h 

図：グラフ 

i 
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2-mode ネットワーク：Biparite（valued）graphs のこと。詳細は以下。 
Temporal networks：動的ネットワーク。時間により変化 
P-Graphs：系図 
Multiple or multi-relational network：同じ頂点集合のネットワーク 
 

1B2.Pajekの概要 

5B2.1Pajekとは 

本書は、windows 用ネットワーク分析ソフト UCINET に組み込まれている大規模ネット

ワーク可視化ツール Pajek のマニュアルである。 
UCINET：UCINET は社会ネットワークとその他の類似データ解析を目的とするメニュー

方式プログラムです。プログラムには、中立性と結合性測度、サブグループの

検出と位置付けメソッド、確率論モデル（P1)、類似・非類似の測度、マトリッ

クス相関（QAP）と多重マトリックス回帰（MRQAP）によるネットワーク仮

説検定などの機能が含まれます。 
これらのネットワーク解析機能に加えて、UCINET は、多次元スケーリング、

クラスター分析、一致分析、および回帰分析などの多変数解析機能を備えてい

ます。さらに、データ変換と管理用のツール（線グラフの作成、グラフ転換、

ノードと結線による事象マトリックス、値付き、または分割グラフからの多重

グラフ作成、グラフのプール化、相関によるセミグループ）を備えています。

これに加え、UCINET は完備したマトリックス代数演算言語を持っています。 
[1] NetScience UCINET6 https://www.netscience.ne.jp/software/ucinet/ 

 
Pajek のネットワークデータの構造は*.net 形式に従う。（*.net は、アスキーコードで書

かれたファイル）*.net ファイルを読み込むことにより、pajek 内にネットワークが構成さ

れる。pajek を使うには*.net ファイルを作る事が始めである。*.net ファイルの作成は、テ

キストエディタから手書きで作ることも出来る。よって、生成されたプログラムに依存す

Opposite arcs Parallel arcs 
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ることなく、*.net ファイルを作れば Pajek で解析できるという意味でどのようなプログラ

ムによって生成されたネットワークでも使うことが出来る汎用性が特徴である。 
 
 Pajek で対象となるネットワーク 
・普通ネットワーク（有向、無向、有向無向混合） 
・マルチリレーションネットワーク 
・2 部グラフネットワーク 
・動的ネットワーク 
 
グラフ：頂点と頂点の関係の数学 
ネットワーク：グラフ上を伝播対象が伝播する存在 
伝播対象：HIV、風邪ウイルス、電力、（物理・化学などの）現象、状態（倒産など）、電波 
     うわさ、パケット、感情など 
数理生態学：拡散方程式や SIR・SIS モデルによる８面格子状（４角形のグリットの上下左

右と斜めの８つへの伝播）伝播を対象にする 
拡散（伝播）ルール：拡散や伝播のルールを決めた方程式・アルゴリズム 
ネットワーク生態学：さまざまなグラフ上（ネットワーク上）の伝播を対象にする。実際

対象のグラフトポロジーで様々な伝播規則を用いるケースが多い 
グラフトポロジー：グラフの形、グラフとも言う 
グラフのリワイヤー：グラフの張りなおし 
頂点特性：頂点が伝播を制御することもある。頂点が伝播対象を保持したり、抑制したり

など 
伝播初期状態：伝播要素の初期状態 
伝播決定要素：グラフのトポロジー、拡散（伝播）ルール、頂点特性、伝播初期状態の４ 

つ 
グラフ評価：グラフ理論より、オイラー路（一筆書きできるか？）など 
ネットワーク評価：対象グラフを伝播させてみる 
類似度測定：グラフトポロジーは基本的に行列データなので、統計的手法によりネットワ

ークの類似度などの測定が可能（グラフ理論の１つ） 
 

Pajek で伝播を扱うことはできない。 
Pajek の Network analysis とは、グラフ評価（graph Analysis)のことで、伝播については

扱わない。ただ、 
・ 伝播していく様子を可視化する 

（*.tim によるスナップショットの時系列可視化） 
・ 伝播の過程のグラフトポロジーの解析をする 
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（次数の数、次数分布、Core など） 
ことは Pajek で扱うことが出来る。 
ネットワークの本質、「伝播」である。一般的にネットワークで一番知りたい本質は、対象

がどのように伝播していくかであるからである。ネットワークトポロジー（グラフ）は、『伝

播の仕方の構造』でしかない。つまり、Pajek でネットワークトポロジーを解析・可視化し

てもネットワークがわかったとはいえない。  
 

 

6B2.2Pajekの使用 

 
Pajek の使用するためには、どのような対象のネットワークでも、まず、*net ファイル

を用意しなければならない。それが、Pajek を使用する第一ステップである。 

ネットワークトポロジー 
（グラフ） 

 
依存関係

Pajek の

対象範囲 

伝播 

ネットワーク 

[一般的な目的] 
知りたいのは伝播 

図：ネットワークと Pajek の対象範囲 



 13

 

7B2.3Pajekのインストールとその方法 

 
 Pajek は以下の URL でダウンロードできる「フリーソフト」である。 
 

Pajek 関連サイト 
H Uhttp://vlado.fmf.uni-lj.si/pub/networks/pajek/U 
 

*.net ファイル

仮想ネットワ

ークデータ 
実測調査 

Pajek 

各種ファイル

ネットワーク

可視化 

図：Pajek の処理の流れ 

計算モデル 
（アルゴリズム） 

数理モデル

（数式） 

統計処理 
(R・SPSS) 

各種処理 
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 以上のURLから、ダウンロードし、インストールすればPajekを使用することが出来る。 
 
 

8B2.4 各種ファイルの説明 

38B2.4.1*.netファイルの説明 

 
 *.net ファイルは、上図のように頂点数の宣言部分と、ラインの宣言部分（有向線の宣言

部分と無向線の宣言部分）に分かれる。 

*Verteces 頂点数 
頂点の宣言部分 

ラインの宣言部分 

*Arcs  
   有向線の宣言部分 

*Edges 
   無向線の宣言部分 

図：*.net ファイルの大まかな構成 
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１行目『*Vertices 頂点数』 
読み込む際に、１行目の宣言頂点数とそれ以降に表示されている頂点データの数が合

わないと、読み込みの際にエラーが発生する。 
２行目~N 行目『頂点番号 “ラベル” 横（x）座標 縦（y）座標 奥（z）座標』 
（N は指定頂点数） 
z 座標は省略可能。 
 
注意点：*.net ファイルに半角シフトでなく全角シフトが入るとエラーが発生するので

注意する。 
 
さらに以下のコマンドで頂点を詳細に設定できる。 

  ・形 
・大きさ 

  ・色 
   

設定項目 コマンド 意味 例 

形の設定 elipse 楕円形にする   

頂点番号 
ラベル 頂点の詳細設定 

（eg.大きさ、色など） 
頂点の座標 
（x,y,z） 

頂点の宣言 
*Vetices 頂点数

図：*.net ファイルの構成（Vertices 宣言部分） 
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box 四角形にする   

diamond 菱形にする   

triangle 三角形にする   

empty ノードを表示しない   

x_fact x 軸方向に何倍拡大するか x_fact 3：x 方向に 3 倍拡大 

大きさの設定 y_fact y 軸方向に何倍拡大するか x_fact 5：y 方向に 5 倍拡大 

ic ノードの内側の色を設定 ic Red：ノード内を赤色にする 

色の設定 bc ノードの枠の色を設定 

bc Blue：ノードの枠を青色にす

る 

表：頂点の設定項目のコマンド 
 
 色の設定は、RGB（Red Green Blue）で指定も出来る。 
 例：ic 0.500 0.500 0.500 
 
  先頭『*Arcs』 
  それ以降の指定『出頂点番号 入頂点番号 重み』 
  で、有向線を指定することが出来る。*Arcs 全体を省略することが可能である。 
 
  先頭『*Edges』 
  それ以降の指定『出頂点番号 入頂点番号 重み』 
  で、無向線を指定することが出来る。* Edges 全体を省略することが可能である。 

 

  さらに以下のコマンドで頂点を詳細に設定できる。 
  ・ラベル 

・色 
 ・形 

図：有向線と無向線 

有向線（Arc） 無向線（Edge） 
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設定項目 コマンド 意味 例 

ラベルの設定 l ラベルを付ける l nakama 

色の設定 c 

紐帯の色を設定す

る c Green 

p Solid 紐帯を実線にする   

形の設定 p Dots 紐帯を点線にする   

表：ラインの設定項目 
 
    色の設定は、RGB（Red Green Blue）でも設定できる。 
        例：c 0.700 0.700 0.700 
 
    紐帯の実線・点線のデフォルト設定は、 
     ・ラインの値（=重み）が正→実線 
     ・ラインの値（=重み）が負→点線 
    となっている。 

 

 
拡張子を.net に指定すれば、Pajek の Mein スクリーンで読み込め、そのファイルを Pajek
で解析、可視化できる。 

 

出頂点 
入頂点 

ラインの値（重み）

詳細設定 

図：*.net のラインの設定 
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39B2.4.2*.clsファイルの説明 
 頂点に対するクラス分けの数字が入る。そのため 
・整数 
・離散数（連続でない） 
 である。 

 
クラスと可視化の色の対応は Draw window の Options>Colors>Partition Colors によって

確認できる。 

図：*.clu のクラス番号と色分けの色の設定

*.clu 

*.net *.net の各頂点にクラス番号を

与える。 

可視化 

クラス番号毎に色分けして可視化される。

図：*.clu の役割 
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クラス番号 
０ 
１ 
２ 
３ 
４ 
５ 
６ 
・・・ 

可視化される色 
水色 
黄色 
黄緑色 
赤 
青 
薄いピンク 
白 
・・・ 

クラス番号と色

の対応表 
[User が自由に

設定できる] 

*.clu 

図：*.clu のクラス番号と色分けの色の設定 

*Vertices 327 
1 
3 
3 
1 
3 
1 
1 
2 
3 
3 
1 
3 
1
図：cls ファイルの構成 

上から頂点番号

1 のクラス番号

1、頂点番号 2 の

ク ラ ス 番 号

3・・・という構

成である。頂点番

号はデータから

省略されている。
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図：*.cls のメインスクリーンの Edit の表示 

 

*.clu *.net 

Pajek 
この例では、「次数＝

クラス番号」とした

処理 

図：クラス番号毎の色分けの例 
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40B2.4.3*.vecファイルの説明 
 頂点の大きさを決定する値である。 
 ・自然数 
・連続数 
である。 

 
*.Vec のデータを「Vector 量」と呼ぶならば、Vector 量と可視化時の頂点の大きさには以

下の関係がある。 

 

 

Vector 量大 

頂点 

図：Vector 量と可視化時の頂点の大きさ

*.vec 

*.net *.net の各頂点に Vector の量を

与える。 

頂点が Vector の量に従い拡大される 

可視化 

図：*.vec ファイルの役割 
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図：*.vec のメインスクリーンの Edit の表示 

 

*Vertices 327 
0.00000000000000000 
0.02436998584237848 
0.03633789523360075 
0.00000000000000000 
0.01225106182161397 
0.00000000000000000 
0.00000000000000000 
0.04215195847097688 
0.06586125530910807 
0.07703633789523361 
0 00000000000000000

図：*.vec ファイルの構成 

上 か ら 頂 点 1 の

Vector 量、頂点 2 の

Vector 量・・・とい

う構成になってい

る。頂点番号はデー

タから省略されてい

る。 
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41B2.4.4*.perファイルの説明 
  *.per は頂点の並び替えのためのファイルである。このファイルは可視化に反映されな

い。 

 

 頂点の再配置とは、下図の如く、言い換えるとラインの張替えである。したがって、*.per
はラインの張替えのためのファイルであるといっていい。 
 
 頂点は張替えられたあとも、ラインの接続関係のデータはそのままであることには注意

する。 
 
 ラインの張替えは、ネットワークサイエンスでよく用いられている手法・手段であり、

Pajek では、「*.per」がこれを受け持つ。 

*.per 

*.net *.net の各頂点の並び替えを行

う。 

 

可視化 可視化に反

映されない 

図：*.per ファイルの役割 
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１ 

2 

3 

“Tanaka” 
3  4  

“kikuchi” 
4  6  

“yamada” 
4  5  

再配置 
1→2 
2→3 
3→1 

１ 

“Tanaka” 
3  4  

2 

“kikuchi” 
4  6  

3 

“yamada” 
4  5  

座 標 を 反

映すると ラインはまったくいじらない

が、頂点のすべての情報を入

れ替える（座標情報も） 

１

“Tanaka” 
3  4  

3 

2 

“kikuchi” 
4  6  

“yamada” 
4  5  

つまり、処理としては頂点の再配

置であるが、やっていることはラ

インの張替えである(Rewire) 

図：頂点再配置とラインの張替え 
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図：*.per のメインスクリーンの Edit の表示 

 
 
 

*Vertices 327 
102 
35 
308 
285 
225 
15 
12 
59 
188 
306 
66 
85
図：*per のファイル構造 

上から頂点番号 1
の再配置頂点、頂

点 2 の再配置頂点

である。つまり、1
→102、2→35・・・

となる。張替え元

の頂点番号はデー

タから省略されて

いる。 
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42B2.4.5*.clsファイルの説明 
   全頂点の部分集合が入る。つまり。クラスターの情報が入ったファイルである。 

 

 

つまり、対象ネットワークを「クラスターかそれ以外か」に分けると考えてよい。 

ネットワーク 
ネットワーク

の部分集合 

*.cls 

抽出 

*.cls ファイルの生成 

*.cls 

*.net 
*.net の各頂点の部分集合

 

可視化 可視化に反

映されない 

図：*.cls の役割 
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Edit 表示をダブルクリックすると、その頂点番号のデータを消すことが出来る 
Add new vertex をクリックすると新しい頂点の情報を追加できる。 

 
43B2.4.6*.hieファイルの説明 
 階層ネットワークの階層のデータが入っているファイルである。 

*Vertices 327 
       1 
       2 
       3 
       4 
       5 
       6 
       7 
       8 
       9 
      10 

図：*cls のファイル構造 

このファイルの場

合、頂点数（327）
は、1~10 までの頂

点がクラスターを

形成しているとい

える。もちろん、

連続の頂点番号で

なくても、クラス

ターを形成するこ

とが出来る。 

図：*.cls のメインスクリーンの Edit の表示 
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図：*.hie のメインスクリーンの Report の表示 

*.hie 

*.net 
*.net の階層性データ

 

可視化 可視化に反

映されない 

図：*.hie ファイルの役割 



 29

 

 
図：*.hie のメインスクリーンの Edit の表示 
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44B2.4.7*.pajファイルの説明 
  * .net から*hie まで、Pajek に関するファイルを一つにまとめたもの。 
45B2.4.8*.logファイルの説明 

 過去に行われたセッションを記録し、再現することが出来る。 

 

*.hie 

Hierarchy>Make 
network 

図：*.hie から階層ネットワークを作成した例 

+"Root" 0 0.000 1096 ""
   +"27" 0 1.000 1 "" 
     *       1 
   +"22" 0 1.000 2 "" 
     *       2 
     *      87 
   +"4" 0 1.000 72 "" 
     *       3 
     *      27 
     *      37 
     *      42 
     *      78 

* 130
図：*hie のファイル構造 
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46B2.4.9*.timファイルの説明 
 ネットワークの成長タイムイベントを指定することが出来る。時間的にネットワークが

変化するので、「動的ネットワーク」と呼ぶこともある。 

  

 「タイムイベントを可視化で反映する」には、以下の手順を踏む。 
① File>Time Events Network>read 
② *.tim ファイルを読み込む 
③ Net>Transform>Generate in Time>All 
④ Select Last Time point で可視化するステップの最後（どのステップまで可視化す

るか）を指定。より正確に表現するなら、どのステップまでネットワーク（*.net）
にタイムを生成するか？（Generate in Time）を指定する。 

⑤ Select Step を入力する。何ステップ毎に可視化したいか（Generate in Time）し

たいかを決定する。 
タイム（ステップ）毎の可視化=*.net にタイムを生成させる 

⑥ 可視化する（Draw） 
⑦ DrawメニューのNextやPreviousで、現時点の可視化するステップを指定できる。 

 
 
 

設定項目 コマンド 意味 

TI t 

t ステップ目のイベントを以下に書くことを宣

言 

タイム TE t ･･･・・・・・・・・・・・・・・を以上で終了する宣言 

頂点 AV v n s 頂点を作る 

ネットワー

ク A 
ネットワー

ク B 
ネットワー

ク C 

*.tim 

時間 
図：動的ネットワークと*.tim 



 32

HV v ・・・・を見えなくする 

SV v ・・・・を見えるようにする 

DV v ・・・・を消す 

(Vertices） 

CV v s ・・・・の特徴を変える 

AA u v s 有向線を引く 

HA u v ・・・・・・を見えなくする 

SA u v ・・・・・・を見えるようにする 

DA u v ・・・・・・を消す 

CA u v s ・・・・・・の特徴を変える 

有向線(Arcs） CD u v ・・・・・・の方向を変更する 

AE u v s 無向線を引く 

HE u v ・・・・・・を見えなくする 

SE u v ・・・・・・を見えるようにする 

DE u v ・・・・・・を消す 

CE u v s ・・・・・・の特徴を変える 無向線

(Edges） EP u v s ・・・・・・を両向有向線に変更する 

PE u v s 両向有向線を無向線に変更する 

AP u v s ・・・・・・・・・・を引く 

両向有向線 DP u v ・・・・・・・・・・を消す 

有向線と無向

線 CT u v 有向線と無向線の変更 

表；タイムイベントのコマンド 
  

タイム t 時間（ステップ）番号 

v 頂点番号 

n ラベル 

頂点 s 特徴 

u 

ラインから出る頂点番

号 

v ラインが入る頂点番号

ライン s 特徴 

表：タイムイベントコマンドの値記号の意味 
 

特徴とは、重さ・形・色などの詳細な属性のこと。 
ラインは、無向・有向・両向有向・無向と有向の変換の 4 つのこと。 
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9B2.5Pajekの各種ウインドウ 

 Pajek は、ウインドウベース（ウインドウで構成されている）プログラムである。主に、

以下の 4 つのウインドウにより構成されている。 

図：*.tim のファイル構造 

*Vertices 1000 
TI 1 
AV 1 v1 
AV 2 v2 
AV 3 v3 
TI 2 
AA 1 2 
AA 2 1 
TI 3 
AA 1 2 
AA 3 1 
TI 4 
DA 2 1 
AA 2 3 
DA 1 2

時間 1 での、 
ネットワーク

の変化 

図：両向有向線 
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  1、メインスクリーン：ファイルの読み書き・コマンド入力という中心的ウインドウ 
  ２、可視化：ネットワークを可視化するためのウインドウ。 
  ３、Report：処理情報を表示するウインドウ。 
  ４、Edit：ファイル情報を表示するウインドウ。 

 

可視化 

Report 

メインスクリーン 

Edit 

図：Pejke、4 つのウインドウ 
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10B2.6Main Screenの構造 

 
1.Network のボックス 

*.net を読み込み、読み込まれたファイル名を表示する。* .net はネットワーク情報で

ある。Pajek の処理のため、中心的なファイルで、これを元に様々なファイル(*.clu、
*.vec など)が生成される。 

2.Partitions ボックス 
頂点の分類のためのファイル*.clu が読み込まれたら表示されるボックス 
（Partition なのに、拡張子が*.clu であることに注意） 

3.Vectors ボックス 
*.vec ファイルが読み込まれたら表示するボックス。*.vec ファイルは、 
頂点の大きさに反映される。 

4.Permutations ボックス 
頂点番号の再配置のための*.per ファイルが読み込まれたら表示するボックス。 
このファイルは視覚化に反映されない。 

5.Clusters ボックス 
頂点の部分集合（サブネットワーク、つまり、クラスター）を作るための*.cls ファイ

ルが読み込まれたら表示するボックス。 
このファイルには、ラインの情報がない。 
このファイルは視覚化に反映されない。 
6.Hierarchies 

メニュー 

ボ ク

各種処理を行うた

めのコマンド 

各種ファイルの

読み書きがなさ

れる 

図：メインスクリーンの構造 
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階層的に頂点を整える*.hie ファイルが読み込まれたら表示するボックス。 

 
Subgroups：階層ネットワークになったときの頂点の部分集合のこと 
Root・Leaf：枝葉の関係。一階層上位の 1 つの頂点を Root（枝）とし、それが所有

している下位の 1 または複数の頂点を Leaf（葉）という。この関係は

どの階層の頂点でも成り立つ。 
 以上をまとめると、メインスクリーンの各ボックスと読み込まれるファイルの種類（拡

張子）は、下図のようになる。 

 

*.net 

*.clu 

*.vec 

*.cls 

*.per 

*.hie 

図：メインスクリーンの各ボックスと読み込まれるファイルの種類（拡張子） 

Root

Leaf

Subgroup 

階層ネットワーク

*.hie 

Root 

Leaf 

図：階層ネットワーク 
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2B3.メインスクリーン上のツールバーの各種メニュー 
11B3.1File 
Pajek の処理に必要な各種ファイルの基本的処理（Read,Edit,Save,Change label,Dispose)
を行う。 

47B>networks 

<Read 
*.net ファイルの読み込みを行う。*.net はアスキーコードで書かれたファイルな

ので、テキストエディタで編集できる。 
<Edit 
編集したい頂点を選択し、その頂点のリンクを追加・削除できる。 
つまり、対象ノードのリンクを編集できるが既存のリンクは修正できない。 
修正したい場合は、一度リンクを消去し、それから追加しなければならない。 

<Save 
*.net ファイルをセーブする。 

<Export Matrix to EPS 
ネットワークのマトリックス（行列）を EPS ファイルとして書き込む。 

EPS（Encapsulated PostScript）：画像ファイルフォーマットのひとつ 
ここでいうマトリックス（行列）とは、ネットワークの視覚化情報をコンピュ

ータ上であらわすデータ構造のことである。以下の、サブメニューは、EPS へ

の書き込み方である。 

 
*Original 

ネットワークの 
マトリックス 

EPS 

以下の方法から一つ選ぶ。

*Original 
*Using Permutation 
*Using partition 

1.Strructual 
2.Delta 

*Only Black Borders

図：Export Matrix to EPS 
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初期状態で EPS ファイルに書き込む。1-mode なら 1-mode で 2-mode な
ら 2-mode で書き込む。 
1-mode：2 部グラフでないネットワーク（通常のネットワーク） 
2-mode：2 部グラフ（同じ頂点部分集合にリンクがないネットワーク） 
 

 

*Using Permutation 
Permutation の.per を反映した EPS ファイルの作成  

*Using partition 
Partition の.cls を反映した EPS ファイルの作成 
1.strructual 
クラスター：Partition によって生成されるグループのこと 
濃度：クラスター内の頂点の数/ネットワーク全頂点数 
   で表される。クラスターがネットワークでどれだけの位置（数、大

きさ）を占めるかを表現できる。各クラスターに 1 つずつ属性とし

てつく数字で、クラスターを表す指標のひとつである。ネットワー

クには複数のクラスターが存在することが普通であるから、1 つのネ

ットワークに複数の濃度の値が存在する。 
   濃度を設定すればどのような頂点がクラスターわけされるか決まる。

ため、（クラスター分類）＝（濃度の決定）である。 
クラス：クラスターのこと。また、2 部グラフにおいては、2 部グラフの一

方と他方のひとつずつを表す。 
 
濃度はクラス間のラインの取りうる最大値に従い標準化される（決定され

る）。 
 

図：2 部グラフ(2－Mode)の例 

First 
subset 

Second 
subset 
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クラス間のライン：クラスとクラスをつなぐラインのこと。 
 
ネットワークは、濃度を反映した、つまり、クラスター分類したネットワ

ーク（Dense Network）に整形される。 
 
2.Delta 
濃度はクラス内にある隣接ノードの最大入力・出力値を持つ頂点（複数）

に従い標準化される（決定される）。ネットワークは、まばらネットワーク

（Spare Network）に整形される。 
 

*Only Black Borders 
すべての、チェックされた行列の中にあるマトリックスは、Black borders
を持つことになる。違う言い方をすれば、white and light squares を持つ

ことになる Dark squares は、Black borders を持つことになる。 
<Change label 

*.net ファイルの名前変更 
<Dispose 

*.net ファイルを消去する 
48B>Time Events Network 

ネットワークのタイムイベントを読み込む。 
<Read time Events 

ctrl+T でショートカットでき、タイムイベントファイルを読み込む。 
<save time Events 

ctrl+I でショートカットでき、タイムイベントファイルを書き込む。 
49B>Partition 

Pertition ボックスに関する.cls ファイルの（Read,Edit,Save,Change label,Dispose)
の処理を行う。 

<Read 
<Edit 
<Save 
<Change label 
<Dispose 

50B>Permutation 

Permulation ボ ッ ク ス に 関 す る .per フ ァ イ ル の （ Read,Edit,Save,Change 
label,Dispose)の処理を行う 

<Read 
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<Edit 
<Save 
<Change label 
<Dispose 

51B>Cluster 

Cluster ボックスに関する.clu ファイルの（Read,Edit,Save,Change label,Dispose)の
処理を行う 

<Read 
<Edit 
<Save 
<Change label 
<Dispose 

52B>Hierarchy 

Hierarchy ボックスに関する.hie ファイルの（Read,Edit,Save,Change label,Dispose)
の処理を行う 

<Read 
<Edit 
<Save 
<Change label 
<Dispose 

53B>Vector 

Vector ボックスに関する.vec ファイルの（Read,Edit,Save,Change label,Dispose)
の処理を行う 

<Read 
<Edit 
<Save 
<Change label 
<Dispose 

54B>Pajek Project File 

<Read pajek 
*.paj：networks から vector まですべてのデータが含まれているファイル 
*.paj を読み込む。 

<save pajek 
*.paj を書き込む 

55B>Repeat session 

 セッション：Pajek 上で過去に行った処理 
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Log ファイル：Pajek 上で過去に行った処理が適宜記憶されているファイル 
*.log ファイルを選択させる。過去のセッションを、*.log ファイルを選択させることで

再現する。 
メインスクリーンの Networks2 段目にログファイルが読み込まれる。 

56B>Show Report Window 

*.net ファイルに関する簡単なレポートを Window に表示する 
57B>Exit 

pajek を終了する。 
 

12B3.2Net 
1 つのネットワーク(*.net)に対する情報追加を行う。また、ネットワークの変形に関するさ

まざまな処理を行う。 
58B>Transform 

<Transpose 
選択したネットワークの置換を行う。 

*1-mode 
1-mode（network）：普通のネットワーク。2-mode でないネットワーク。 
1-mode ネットワークの有向線の向きを変える。 

 
*2-mode 

Rows（行）と Cols（列）を置換する。 
2-mode：2 部グラフ 
Row：行 
Col：column の略、つまり、列 

Transpose 
*1-mode 

図：Transpose *1-mode 
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<Remove 
ネットワークの構成要素の“消去”を行う。 
Removeで行う処理と同等の操作は*.netファイルの arcsや edgesのラインを

手動消去することである。このメニューは、膨大な数の頂点・ラインをメニ

ューで消去することが出来る。 
ライン：以下の図を参照 

 
図：2-mode のランダムネットワーク 

First subset 

Second subset 

  

First subset と Second subset
が変換されている。 

図：Transpose *2-mode 
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*Selected vertices 
選択した頂点を消去する。 
手順 
①『Selected vertices to remove』のコマンドボックスが出るので、消去

したい頂点番号を入力する 
②入力した頂点が*.net ファイルから消去される。 

*All Edges 
選択したネットワークのすべてのエッジ（無向線）を消去する。 

*All Arcs を押す 
選択したネットワークのすべての Arcs（有向線）を消去する。 

*Multiple Lines を開く 
選択したネットワークの Multiple Line を消す。 
Multiple line：特定の有向線(Arc)や無向線(Edge)、すなわち、特定の「順

序（秩序、配列）ある」または「順序（秩序、配列）ない」

頂点のペア、一回以上起きるとき、これらは、Multiple line
である。 

 
      つまり、特定のライン（Multiple Lines）を消すということである。 

無向線 有向線 両向有向線 

ある頂点間の特定のライン 
（= Multiple Lines） 

無向線 有向線 両向有向線 

ライン 
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1.Sum Values 
Values：edge や arc の重みの値のこと 
すべての消去されたラインの値は、一致した２頂点間の消去されてい

ないラインの値が加えられる。 
重みを考慮したくなくなったとき 
edge や arc の頂点間の線は消さずに、重みだけ消す。 
重みはすべて 1 になる 

 
2.number of lines を押す 
オリジナルのネットワークの 2 頂点間の値を新しいネットワーク 2 頂点

間に一致させる。 
Sum Values とどこが違うか？ 

3.Min value 
すべての２頂点間の最小値を選ぶ 
繰り返し行うと、少ない値から消えていく 

4.Max value 
すべての２頂点間の最大値を選ぶ 
繰り返し行うと、少ない値から消えていく 

5.Single Line 
重みを１にする。 

*loops 
ループ(loop)：ある頂点から出て同じ頂点に入る。 

Edges 
      1      2       1 
      2      3       1 
      2      5       1 
      3      4       1 
      3      8       1 
      5      6       1 
      5      7       1 
      8      9       1 
      9     10       1 
      9     12       1 

10 11 1

ライン(Edges・Arcs)の重み 
line values 

(arcs のときも同様) 

図：line values 
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ループを消す。 
ループのないネットワークにしたいときの処理。 

*Lines with Value 
1.lower than 
特定の値より低い値（line values）のラインをすべて消去する。 

2.higher than 
特定の値より高い値（line values）のラインをすべて消去する。 

3.within interval 
特定の値間のラインをすべて消去する。 

*All Arcs form each Vertex expect 
各々の頂点が予測するすべての有向線。有向線ネットワークでなければなら

ない。 
1.K with Lowest Line Values 

Sort=分類する、種類 
ラインを出ラインの値（重み）に従った昇順で頂点間を分類する。選んだ

数字の最小ラインを保つ。 
   K：指定した数字 
   入力手順 
    ①How many lowest output arcs to keep,0 - keep 

2.K with Highest Line Values 
ラインを出ラインの値（重み）に従った降順で頂点間を分類する。選んだ

数字の最大ラインを保つ 
 

<Add  

１

Loop 

*.net ファイルでは、

*Edges 
1 1  1 
と表現される。（ライ

ンの値 1 の場合） 

図：Loop と*.net ファイルの構成 
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ネットワークの構成要素の“追加”を行う。 
*Vertices 
頂点の追加。同等処理は、*.net ファイルの Verteics のテーブルに、新しい

頂点情報を書き込むことである。 
*Source and Sink 

sink：流す 
もし、非環状のネットワークなら（acyclic のネットワーク以外は受け付け

ないメニューである。）、固有のはじめと終わりの Vertex を追加する。下例

では、始めが 101、終わりが 102 になる。）新しいネットワークは、２つの

人工の２頂点を持つ。（頂点 101 と 102 のこと） 
 入力項目 
  ①Values on lines added（加えられる頂点から追加されるラインの値） 

 

図：Add *Source and Sink 
 

矢印方向の有向

ネットワーク 

追加される

頂点（終点）

追加される

頂点（始点）

この状態が、Sink（流

す）状態である。 

図：Add *Source and Sink 
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*Default Vertex Labels 
現在の頂点ラベルからデフォルトのラベルへ再配置する。デフォルトのラベ

ルとは、『v 頂点番号』である。 
例：各ラベルが以下のように変更される。 

    *Vertices 3 
     1  “c”→”v1” 
     2  “n”→”v2” 
     3  “p”→”v3 

*Vertex Labels from File 
別の*.net ファイルを読み込み、そのラベルを、現在 pajek に読み込まれて

いる*.net の頂点ラベルに書き換える。 
*Line Labels as Line Values 
  ラインのラベルを、ラインの値（重み）と共に再配置する。 
*Sibling Edges 

Sibling（兄弟の一人） 
Sibling Edges： 
兄弟無向線の共通した頂点を加える。 
 1.input 
先祖の有向線 

101 
102 

頂点数 100 非環ネットワークの端点をつな

げる頂点 101、102 が生成される。 
つまり、Sink する。非環ネットワークの始

まりが 101 で終わりが 102 になる。 

図：Add *Source and Sink の例 



 48

2.Output 
    子孫の有向線 

 
<Edges->Arcs 

Convert all edges to arcs (in both directions) (make directed network) 
Both directions=両向 
無向線を両向有向線にする。 

 

.net ファイルには、以下のようになる。 

無向線 両向有向線 

Edges->Arcs 

図：Edges->Arcs 

図：*Sibling Edges input の例 
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*Arcs 
       1        2 1  
       2        3 1  
       2        5 1  
       3        4 1  
       3        8 1  
       5        6 1  
       5        7 1  
・・・（中略）・・・・ 
     324      325 1 
      324      326 1 

2        1 1   
3        2 1  

       5        2 1  
       4        3 1  
       8        3 1  

6 5 1

元のArcs指定と反対方向のArcsを指定

していることがわかる。 

Edges->Arcs 処理

後の追加項目。 

注目 

つまり 

両向有向線の指定は、 
ある向きと、まったく逆向きの指定を行

えばよい。 

図：両向有向線と*.net の関係 
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図：無向線から両向有向線に変換した例 

 
<Arcs->Edges 

*All 
すべての有向線（Arcs）から無向線（Edges）へと変換する。つまり、 
有向ネットワークから無向ネットワークを作る 

 

*Bidirected only 
Bidirect：both direct 

有向線 無向線 

Arcs->Edges 
*All 

図：Arcs->Edges *All 
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Bidirect：両向有向 
両向有向線のみ無向線とする。 

 

両向有向線は、2 つの逆向きの有向線を重ね合わせた形であるが、以下のよう

に 2 つの有向線のラインの値（重み）が違うこともある。 

 

1.Sum Values 
新しい無向線は、両向有向線の値の合計値である。 
上例では、1-2 の無向線の値（重み）は 1+10=11 となる。 

2.Min Value 
新しい無向線は、両向有向線の値の最小値である。 
上例では、1-2 の無向線の値（重み）1 となる。 

3.Max Value 
新しい無向線は、両向有向線の値の最小値である。 
上例では、1-2 の無向線の値（重み）10 となる。 

 
<Line Values 
ラインの値（重み）を変化させる。 
＃ラインの値（重み）について＃＃＃＃＃＃＃＃＃＃＃＃＃＃＃＃＃＃＃＃＃ 
 ラインにも値（重み）がつくことがある。そのラインに伝播がされればされ

るほど多くの値（重み）がつくと考えてよい。例えば、道路でも交通量の激

両向有向線 無向線 

Arcs->Edges 
*Bidirected only 

図：Arcs->Edges *Bidirected only 

*Arcs 
1        2 1 
2        1 10 

重みが違う 
無向線になっ

た と き の 値

は？

以下の 3 つの中

で調整する。 



 52

しい道路と少ない道路が存在し、それらを同列に考えるよりも値（重み）を

付けて考えた方がより実質的である。可視化についてもラインの値（重み）

により、ラインが細くなったり太くなったり（あるいはより黒く、からより

白くとの色分けがされたり）とラインの値（重み）を反映した可視化も存在

する。 
  Draw window：Options>Lines>Different width あるいは Gray scale をチ

ェック。（詳細は、これらのコマンドの説明しているページへ） 

 

     他にも、 
        ラインの値が大きい=伝播の確率が高い 
     という意味もある。 
     これらのように、ラインの値（重み）は重要な意味を持つ。 

＃＃＃＃＃＃＃＃＃＃＃＃＃＃＃＃＃＃＃＃＃＃＃＃＃＃＃＃＃＃＃＃＃＃＃ 
*Recode 
 ラインの値を選ばれた間隔（頂点間）とこの方法でのラインの値（重み）

の再設定に従い確率的に分配する。 
 入力項目 
  ①Dividing values or #Clusters 

      100......1 21 ≤≤≤≤ nxxx の n を入力。つまり 1~100 のラインの値

（重み）の n 個のクラスに分割する。 

ラインの値（重み）

が大きい 

たくさん伝播する。 
（あるいはその結果、ラインの値（重

み）が大きくなった。） 

ラインの値（重み）

が小さい。 

少ししか伝播しない。 
（あるいはその結果、ラインの値（重

み）が小さくなった。） 

Line value=10 Line value=1 

図：ラインの値（重み）と伝播 
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    ②Generate new network with line values recorded in this way? 
       Yse/no 
       Yes：この方法で作られたラインの値（重み）を新しいネットワー 
      ク（*.net）に反映する。 
    No：反映しない。 

 

Lowest value of line:  1.0000 

Highest value of line: 100.0000 

 

         Line Values             Frequency       Freq%  CumFreq  CumFreq% 

-------------------------------------------------------------------------- 

 (            ...     1.0000]          673     99.8516      673   99.8516 

 (     1.0000 ...     3.0204]            0      0.0000      673   99.8516 

 (     3.0204 ...     5.0408]            0      0.0000      673   99.8516 

 (     5.0408 ...     7.0612]            0      0.0000      673   99.8516 

 (     7.0612 ...     9.0816]            0      0.0000      673   99.8516 

 (     9.0816 ...    11.1020]            0      0.0000      673   99.8516 

 (    11.1020 ...    13.1225]            0      0.0000      673   99.8516 

 (    13.1225 ...    15.1429]            0      0.0000      673   99.8516 

 (    15.1429 ...    17.1633]            0      0.0000      673   99.8516 

 (    17.1633 ...    19.1837]            0      0.0000      673   99.8516 

 (    19.1837 ...    21.2041]            0      0.0000      673   99.8516 

 (    21.2041 ...    23.2245]            0      0.0000      673   99.8516 

 (    23.2245 ...    25.2449]            0      0.0000      673   99.8516 

 (    25.2449 ...    27.2653]            0      0.0000      673   99.8516 

 (    27.2653 ...    29.2857]            0      0.0000      673   99.8516 

 (    29.2857 ...    31.3061]            0      0.0000      673   99.8516 

 (    31.3061 ...    33.3265]            0      0.0000      673   99.8516 

 (    33.3265 ...    35.3469]            0      0.0000      673   99.8516 

 (    35.3469 ...    37.3674]            0      0.0000      673   99.8516 

 (    37.3674 ...    39.3878]            0      0.0000      673   99.8516 

 (    39.3878 ...    41.4082]            0      0.0000      673   99.8516 

 (    41.4082 ...    43.4286]            0      0.0000      673   99.8516 

 (    43.4286 ...    45.4490]            0      0.0000      673   99.8516 

 (    45.4490 ...    47.4694]            0      0.0000      673   99.8516 

( 47 4694 49 4898] 0 0 0000 673 99 8516
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*Multiply by 
継続的にラインの値を増やす 
 入力項目 
  ①Multiply line values by 
      継続的に増やしていくラインの値（重み）の数 

(    49.4898 ...    51.5102]            0      0.0000      673   99.8516 

 (    51.5102 ...    53.5306]            0      0.0000      673   99.8516 

 (    53.5306 ...    55.5510]            0      0.0000      673   99.8516 

 (    55.5510 ...    57.5714]            0      0.0000      673   99.8516 

 (    57.5714 ...    59.5918]            0      0.0000      673   99.8516 

 (    59.5918 ...    61.6122]            0      0.0000      673   99.8516 

 (    61.6122 ...    63.6326]            0      0.0000      673   99.8516 

 (    63.6326 ...    65.6531]            0      0.0000      673   99.8516 

 (    65.6531 ...    67.6735]            0      0.0000      673   99.8516 

 (    67.6735 ...    69.6939]            0      0.0000      673   99.8516 

 (    69.6939 ...    71.7143]            0      0.0000      673   99.8516 

 (    71.7143 ...    73.7347]            0      0.0000      673   99.8516 

 (    73.7347 ...    75.7551]            0      0.0000      673   99.8516 

 (    75.7551 ...    77.7755]            0      0.0000      673   99.8516 

 (    77.7755 ...    79.7959]            0      0.0000      673   99.8516 

 (    79.7959 ...    81.8163]            0      0.0000      673   99.8516 

 (    81.8163 ...    83.8367]            0      0.0000      673   99.8516 

 (    83.8367 ...    85.8571]            0      0.0000      673   99.8516 

 (    85.8571 ...    87.8775]            0      0.0000      673   99.8516 

 (    87.8775 ...    89.8980]            0      0.0000      673   99.8516 

 (    89.8980 ...    91.9184]            0      0.0000      673   99.8516 

 (    91.9184 ...    93.9388]            0      0.0000      673   99.8516 

 (    93.9388 ...    95.9592]            0      0.0000      673   99.8516 

 (    95.9592 ...    97.9796]            0      0.0000      673   99.8516 

 (    97.9796 ...   100.0000]            1      0.1484      674  100.0000 

-------------------------------------------------------------------------- 

  Total                                674    100.0000 

図：*Recode によって出力される結果 Report の例 



 55

*Add Constant 
継続的にラインの値（重み）を加えていく。 
 入力項目 
  ①Constant to add to line values 

*Absolute 
 Absolute line values 
*Absolute+Sqrt 
  Square root of line values 

Sqrt：Square root 
*Truncate 
  ラインの値（重み）を切り捨てる。 
*Exp 
 Exponent line values 
*ln 
  Natural logarithm of line values 
*Power 
  Selected power of line values 
  Power： 
*Normalize 

ラインの値（重み）を標準化する。他のネットワークのラインの値（重

み）と比較しやすくなる。 
1.Sum 
ラインの値の合計値を１とし、その前提の下で、すべてのラインの値

を再計算する。 
2.Max 
最大値のラインの最大値を１とし、その前提の下で、すべてのライン

を再計算する。 
<Reduction 

     以下の対象を縮小する。 
*Degree 

       選んだ値よりも小さいすべての頂点を（縮小的に）消す。 
1. Input 
2. Output 
3. All degree 

       操作は、選ばれたネットワークを限定的にすることが出来る。 
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*Hierarchical 
0 か 1 の隣接 (Neighbor)をもつすべての頂点を（縮小的に）消す。 

 
結果は、簡素なネットワークと消された頂点の階層となる。 
オリジナルのネットワークは最後に元通り(restore)にする。 

*Subdivisions 
    Subdivisions：副分割、副分配、副分類 
   正確に２隣接をもつすべての頂点を消す。（2 つのラインと共に） 
   2 隣接とは、上記の 0 や 1 の隣接と同じく 2 つの頂点とつながった、次数 2

の頂点のことである。 
   代わりにそれら 2 つの近接に直接、ラインを加える。 

 
   結果、可視化するのにちょうどよい簡素なネットワークになる。 
   だだ、オリジナルのネットワークは最後に元通りにならない。 

Reduction 
Subdivisions 

図：Reduction *Subdivisions 

0 の隣接 1 の隣接 

次数 0 次数 1

図：0 の隣接と 1 の隣接 

他の 1 つの頂点

と隣接している 
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*Design(McCabe) 
   すべてのネットワークの部分を McCabe（グラフを描く際のプログラム）に

従い縮小する。同サイズの Partition が必要。 

 
有向線が追加され、頂点数も 327 から 222 へと減少する。 

*Structural(flow graph) 
 

<Generate Time 
読み込まれた*.tim ファイルに従うステップ時の状態を*.net ファイルへ。 
特定の時間かその間を取る。 

     －：頂点間の限界(Interval of limit)より少ないか多いかで分ける 
      ‘：頂点間を分ける 
     ＊：無限大 
 

例：Vertices 3 
         1 “a” [5-10,12-14] 
         2 “b” [1-3,7] 
         3 “e” [4-*] 
         Edges 
         1 2 1 [7] 
         1 3 1[6-8] 
         頂点 a は、5~10 と 12~14 のタイムで働き（Active）頂点ｂは、1~3、

7 のタイムで働き、頂点 e はタイム 4 から働く。ライン１から 2 はタイ

ム 7 で働き、ライン 1 から 3 はタイム 4 から働く。（3 番目の数字は重

 

図：All degree の partition に従った Mc Cabe 描写 
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み） 
       指定されたタイムのときのみ、現在のネットワーク（temporal 

network）に表示される。 
*All 
すべての特定の時間のネットワークを生成する。 

*Only Different 
変更点が存在したときのみ、ネットワークを生成する。 

*Interval 
       選択された Interval（時間）を与えたラインや頂点のあるネットワークを

生成する。 
<1-mode to 2-mode 

1-mode から 2mode ネットワークを生成する。 
<2-mode to 1-mode 

2-mode から 1-mode ネットワークを生成する。 
*Rows 
結果は、ネットワーク間の行要素（アクター)間の関係を入れたネットワー

クとなる。 
ラインの値（重み）が、2 アクター共通のイベントの数を数える。 

*Columns 
結果は、列要素（イベント）間の関係を入れたネットワークとなる。 
ラインの値（重み）が、互いのイベント間を構成するアクターの数を数え

る。 
*Include loops 
それぞれのアクターのイベントから合計値（互いのイベントのアクターの

数の合計値）にループの値を入れたいとき、このメニューを使用する。 
*Multiple lines 
頂点が存在する間に Multiple lines 存在する箇所に、値のない 1-mode ネッ

トワークを生成する。 
*Normalize 1-mode 
 2-mode から 1-mode になった 1-mode ネットワークを標準化する。 
 オプションには「Include loops のチェック」と「Multiple lines のチェッ

クをしない」がある。 
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2-mode から 1-mode になった 1-mode ネットワークは、見やすくない。（ほと

んどまばらでない。）そこで、以下のようにまばらにすることも出来る。 
 Net>Transform>Remove>Lines with value>lower than 
*Rows=Cols 
 同じ頂点数の部分集合（First subset と second subset）をもつ 2-mode を

1-mode に変換する。当然、2 つの部分集合は同じ頂点数の 2-mode ネット

ワークでないと処理を受け付けない。 

 
<Multiple relation 

*Extract Relation(s) 
 選択された multiple relations network から、選択された関係リスト（List 

of relations）かそれを引き出す。 

 

部分集合25と25の同じ

頂点数の 2-mode 
頂点数 25（つまり半分

の）1-mode へ 

図：2-mode to 1-mode *Rows=Cols 
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 入力項目 
  ①Relation Number(s)の選択 
*Canonical Numbering 
 1,2,...と順次的に関係の数を数え上げる。 
*Generate 3-Mode Network 

1-mode か 2-mode の相互関係（multirelational network)ネットワークから

3-mode ネットワークを生成する。 
Multirelational network の互いのラインｒ： i j v 
(i から j へ行く、値 v の relational number r) 

 
                     N：1-mode(first mode)の濃度 
           M：2-mode(second mode)の濃度 
                ・1-mode network 

 

                      以上の関係式から、新しいラインが創出される。 
 

*Arcs 
       1        2 1        

2        3 1  
       2        5 1  
       3        4 1  
       3        8 1 

i j v

1 
2 
3 
4 
5 

r 

図：*.net ファイルとｒ： i j v の関係 
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*Line Values->Relation Numbers 
ラインの値（重み）と同じ関係番号を保存する。（ラインの値は、完全な小

数点以下切捨ての値：実数の整数化）つまり、ラインの値（重み）を関係

番号にする。（Line Values→Relation Numbers） 
*Relation Numbers->Line Values 
関係番号と同じラインの値（重み）を保存する。つまり、関係番号をライ

ンの値（重み）にする。（Relation Numbers→Line Values） 
*Change Relation Number/Label 

頂 点 番 号 1~25 の

1-mode ネットワーク 
倍の 25 頂点が追加され、51 番

目の頂点に集中する形となる。 

Kamada-ka
wai 最適化 

51

中央のオーソリティが 51. 

図：Multiple relation  *Generate 3-Mode Network 
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関係番号をラベルと一致した値の新しい関係番号に置き換える。 
<Sort Lines- 
 ラインの並べ替えを行う。 

*Neighbors around Vertices 
 近隣の回りのラインの並び替えを行う。 
 他の最終頂点（End-vertex）に従った昇順の中で、互いの頂点の並び替た

ラインに結合された、互いの頂点の並び替たラインに向かって、近隣の周

りの頂点のラインを並び替える。 
*Line Values 
  ラインをラインの値（重み）に従い、昇順か降順に並び替える。 

１．Ascending 
  昇順に並び替える。 
２．Descending 

  降順に並び替える。 
 

59B>Random Network 
選択された項目に従い、ランダムネットワークを生成する 

<Total No. of arcs 
vertice の数と arcs の数を聞き、有向線ランダムネットワークを生成する。 

<Vertices Output Degree 
 ネットワークの定義数（=頂点数）と与えられた距離の互いの頂点の出次数を反

映した有向線ランダムネットワークを生成する。 
 入力項目 

①頂点数 
②Min number of arcs from vertex 
③Max number of arcs from vertex 
④Multiplu line を除くか？ 

<Erdos-Renyi 
Erdos-Renyi のモデルに従い 2-mode ネットワークを生成する。 
すべての潜在的なラインに含まれている顕在化する確率 p  
確率 p の代わりにもっと直感的なものに、以下の次数の平均が使われる。 

∑
∈

=
Vn

V
n

)deg(1deg  

補足：グラフ ),( LVg = 、V は頂点の集合、 Aは有向線の集合、 Eは無向線の

集合、 L はラインの集合で AEL ∪= 。 )(Vcardn = （card は要素）

)(Lcardm =   
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それは、
maxm
mp = を保つ。またシンプルなグラフ向けである。 

または、
n
m2deg =  

 *Undirected 
  無向ネットワークを生成する。頂点数と平均距離を聞いてくる。 

平均距離：ある頂点がどのくらいの範囲の頂点とリンクできるかという距

離の平均。平均距離が大きいほど完全グラフに近くなる。 
     平均距離の最大値=完全グラフ 

   1. General 
         普通の形のネットワーク。 
     2. Bipartite 
     2 部からなるネットワーク。 
     3. 2-Mode 
     2-mode。 
  *Directed 
   1. General 
    普通の形のネットワーク。 
   2. Acyclic 
    Acyclic のネットワーク。 
   3. Bipartite 
      4. Acyclic Bipartite 
    

<Scale Free 
スケールフリーの無向、有向、無環ネットワークを生成する。 
エンドポイントのエッジは以下の確率に従った値にランダムにすべての頂点間

が選択される。 

  
VE

vout
E

vinv 1)deg()deg()Pr( γβα ++=  

  そのとき、 
  1=++ γβα  
  さらに、 

  ∑ ∈
=

Vv
v 1)Pr(  

*Undirected 
        入力項目 
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    ①頂点数 
    ②ライン数 
    ③平均距離 
    ④Initial Erdos-Renyi graph:頂点数 
    ⑤Initial probability of lines(0~1) 
    ⑥Alpha (α) 
      *Directed 
    ①頂点数 
    ②ライン数 
    ③平均距離 
    ④Initial Erdos-Renyi graph:頂点数 
    ⑤Initial probability of lines(0~1) 
    ⑥Alpha (α) 
    ⑦Beta(β) 
      *Acyclic 
    ①頂点数 
    ②ライン数 
    ③平均距離 
    ④Initial Erdos-Renyi graph:頂点数 
    ⑤Initial probability of lines(0~1) 
    ⑥Alpha (α) 
      *Adding 
         ・free 
       「選択する」か「解除する」かのチェック項目。 
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図：スケールフリーの設定 Report 

 
図：以上の設定によって可視化されたグラフ 

 
<Extended Model 
アルバート・バラバシの Extended Model を作る。 
   入力項目 
   ①頂点数 
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   ②孤立頂点の数 
     10 ≥m の m を入力(1 以上 10 個単位) 
   ③How many lines to add in each step 
   ④新しいラインを追加する確率(0~1) 
   ⑤リワイヤ（ラインの張替え）する確率 
   ⑥multiple line を除去するか？ 

 

図：Extended Random Network [3, 2, 0.333, 0.333] (1000)の頂点４からのパス数で 
Partition したもの（Net>Partition>k-neighbor の ALL）。1000 頂点のほとんどが 2 パス

でいける（2 パスの近隣）黄緑色であることがわかる。 
 

60B>Partitions 
ネットワークを Partition（クラス分け）する。出力は、*.clu ファイルがメインスクリ

ーン Partitions ボックスに出力される。 
<Degree 
 頂点の次数（Degree）で Partition する。このように、頂点の次数による Partition 
 を便宜上「Degree Partition(次数によるパーティション)」と名づける。 

Partitions と Vector のボックスにファイルが生成される。 
Partition と Vector には、「Degree Partition」されたデータが入るが、 
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Partition はクラスごとの色分け、Vector は次数の多くなるに従い、頂点が大き

くなるネットワーク可視化を担当する。 
*Input 
入次数による Degree Partition を生成する。 

*Output 
出次数による Degree Partition を生成する。 

*All 
 次数（入次数、出次数の区別なく）による Degree Partition を生成する。 
 

 
図：初期可視化状態の Degree Partition（ALL）の可視化例 

色毎にパーティションされる。 
次数と色の対応は、Partition の色の対応設定に依存する。 

Draw window の Options>Colors>Partition Colors でみることが出来る。 
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図：Circle－Partition による Degree Partition（ALL）の可視化例 
次数でクラスわけされた Petition ごとに、円状に表示 

クラスターを飛びえたリンクは、次数の違うもの同士のリンクとなる。 
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図：kamada-kawai 最適化による Degree Partition（ALL）の可視化例 
次数ごとに色分けされていることが確認できる。 

 
  *.clu ファイルと共に、*.vec ファイルも生成される。これは、次数が大きいほ

ど Vector が大きい値をとるファイルである。 

 
図：Degree Partition（ALL）で生成された Vector ファイルによる可視化例 
<Domain 
 Domain：領域 
 互いの頂点のため、入力、出力及びすべての隣接に従ったそれの領域を計算す

る。結果は、 
１．領域のサイズの Partition－頂点に到達できる数 
２．標準化された領域のサイズのVector－標準化は頂点の合計数を 1にする。 
３．領域の~から~ までの平均距離の Vector 

の 1 つの Partiton と 2 つの Vector である。 
近接誘因指標（Proximity Prestige index）は分けている標準化された平均距

離の領域のサイズによって計算できる。 
入力項目 
①Maximal distance．distance (0-No limit) 

0 から限界数（頂点数）までの最大距離を入力。 
*Input 
*Output 
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*All 
<Core 
 Core（コア）には以下の 3 つが存在する。 
  １．K-Core：最大 k 個以上の次数を持つ最大サブグラフ 
  ２．M-Core：Island のこと（Pajek では M-Core といわず、Island という。） 
        最大 m 以上のラインの値（重み）を持つ最大サブグラフ 
  3．P-Core： 
  

     K-Core は、処理的にいえば次数による Partition である。では、次数による

Paritition（Degree Paritition）とはどこが違うだろうか？以下で明確にする。 
 

以下のように考えるとわかる。つまり、K-Core は水面下に入るものと水面上に

出るものという風に考えることが出来る。上図では、次数 3 以下が水面下に（ク

ラス番号 1）次数 4 以上が水面上に（クラス番号 2）出ると考えることが出来る。 
     この水面の上か下かの基準 k は、コンピュータによって自動で決定されえるた

め、User は設定できない。 

次数 クラス番号 

1 1 

2 2 

3 3 

4 4 

5 5 

6 6 

7 7 

8 8 

Degree Paritition 

次数 クラス番号

1 1 

2 1 

3 1 

4 2 

5 2 

6 2 

7 2 

8 2 

k-core 

クラス番号に

明確な線引き

がされる。この

場合、次数 3 と

4 の間にある。

定義より、これ

は 4-core。 

図：Degree Partition と k-core の違い 
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さらに、最大サブグラフという制限があり、最大でないサブグラフの次数ｋ以上のサブグ

ラフはすべて対象から除かれる。（クラス番号が 1 となる） 
 

 

つまり、以下のような処理過程となる。 

 

図：自動的に決定される k-core 

コンピュータ（Pajek） は、このネットワー

クに対しコア数 2 を選択。つまり 2-core 

自動 
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図：K-Core(ALL)による Partition 可視化（kamada－kawai 最適化）2-core 

黄色：クラス番号１ 
黄緑色：クラス番号 2 

このネットワークの 2-core は黄緑色全体のサブグラフである。 
（次数 2 のサブグラフでも、クラス番号 2 となっているところが散在するが、これは、Step2

が存在しているためである。） 
 
    ちなみに、特定のクラス番号とそれ以外を 0 と 1 で区別するコマンドがある。

次数 k 以上のサブグラフを作り、そのクラス番号

を 2 とし、それ以外を 1 とする。 

最大なサブグラフ以外は、すべて次数に限らずク

ラス番号を 1 とする。 

最大のサブグラフのみ、クラス番号 2 となる。

k-core 

図：k-core の形成過程 

Step1 

Step2 
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Degree partition をつくり特定の次数のみを 1 で表すことも出来る。 
      Partition>Binarize 
     また、特定のクラス番号を別のクラス番号へと変換するコマンドもある。 
      Partition>Fuse cluster 
 
   Core と Island の違いは、 
     Core：次数に注目  
     Island：ラインの値（重み）に注目 
   である。 
 

*Input 
 線が頂点の中に来るもの（入次数） 
*Output 

  線が頂点から出て行くもの（出次数） 
*All 

  頂点の隣接数（入次数も出次数も関係ないただの次数） 
*2-Mode 

 
 
First subset の最小次数の全頂点の集合：k1 
Second subset の最小次数の全頂点の集合：k2 

        処理手順 
        ①k1 と k2 を作る 
        ②k1 と k2 の頂点には、Partition 番号 0 が割り振られる 
        ③k1 と k2 以外の頂点には Partition 番号１が割り振られる 

図：2 部グラフ(2－Mode)の例 

First 
subset 

Second 
subset 
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        ④Partition 番号１のサブネットワークが 2-Mode の Core である 
*2-Mode Review  

k1、k2Rows Cols Comp に従い処理 
Comp：comprehensive 
Comprehensive：包括的な 

*2-Mode Border 
Compute only border values of k1 and k2 for a given 2-mode 
network 
与えられた 2-mode の k1、k2 を唯一のボーダーの値とした計算 

<Valued Core 
*First Threshold and Step 
はじめに閾値を選び、閾値を上げていきながらステップする 
聞いてくる値 
①First threshold： 
②Step(>0)：上昇させていく閾値のステップ 

 
 1. Input 
  入次数による Valued core 
 2. Output 
  出次数による Valued core 
  3. All 
  無向線による Valued core 

次数 

頂点の距離が近い順に並び替えた頂点 

Island の

基準の値 

Core 

図：Core 生成の原理 

この閾値の線の上昇が

ステップ。 
Core が変わっていく。
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図：ALL で First threshold：1・Step：20 の結果 

 
図：ALL で First threshold：1・Step：20 の結果の可視化 

*Selected Thresholds 
Thresholds (increasing numbers) are given using vector 
  1. Input 
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 2. Output 
  3. All 

*Use max instead of sum 
<Depth 

Depth：深さ、奥行き 
*Acyclic 

Acyclic：非環状の 
Acyclic ネットワークでないと受け付けないメニュー 
頂点の奥行きに従った、Acyclic ネットワークの Partition 

*Genealogical 
Genealogical：系図の 
頂点の Layer に従った系図のネットワークの Partition 

<p-Cliques 
Clique：グラフ理論上で、すべてのノードが互いに直接的な紐帯で連結してい

るグラフ 
クリークとは、つまり完全グラフのことである。 

 

P：number between 0 and 1（0 から 1） 
p-Cliques：少なくとも、クラスター内に確率 p（0~1）の近隣を持つ頂点を持つ

クラスターを Partition する 

図：clique 
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     つまり、確率 1（100%）の p-clique は、完全にラインを引いた p-clique で、つ

まり、clique（完全グラフ）である。 
     p-Cliques に従い、Partition する。Partition ボックスに*.cls ファイルが生成さ

れる。 
     入力項目 
      ①確率 

*Strong 
for directed network（有向線を持つネットワーク） 

 

クリークから、確率 p
だけラインを引いたク

リーク(p-clique) 

図：p-clique 
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図：確率 0.5 の Strong p-Clique 

*Weak 
for undirected network（有向線を持たない、つまり無向線を持つ 

ネットワーク） 
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図：確率 0.5 の Weak p-Clique 

<Vertex Labels 
同じ頂点ラベル=同じクラスとする Partition 

<Vertex Shapes 
同じ頂点の形＝同じクラスとする Partition 
頂点の形＝.net で指定できる 

<Islands 
重さ：ラインの重さがあるネットワークの頂点の Partition 
（Weight：Partition vertices of network with values on lines） 
Islands：ラインの値（重み）による最大サブグラフ（別称：M-Core） 
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Island に似た概念である Core も同様で、y 軸の「Line value(ラインの値・重さ)」
の代わりに「頂点の次数」になる。 

 
*Line Weights 
 入力項目 
① Island の最小サイズ 
② Island の最大サイズ 

次数 

Island の

基準の値 

Core 

図：Core 生成の原理 

最大サブグラフのみ Core 

頂点の距離が近い順に並び替えた頂点 

Line value(ライン

の値・重さ) 

Island の

基準の値 

Island 

図：Island 生成の原理 

最大サブグラフのみ Island 

頂点の距離が近い順に並び替えた頂点 
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*Line Weights[Simple] 
  入力項目 
③ Island の最小サイズ 
④ Island の最大サイズ 

     *Generate network with Islands 
             [選択項目] 

<Bow-Tie 
「Bow-Tie」のパーティション形式に従った Partition。 

1-LSCC 
2-IN 
3-OUT 
4-TUBES 
5-TENDRELS 
0-OTHERS 

 
図：Web の Bow-Tie グラフ[manual 18] 
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図：Bow-Tie 後に表示される Report 

 
      有向線ネットワークを巨視的に見ると、bow-tie の形式となっている。 

１、有向線ネットワークの中心部分 
２、有向線ネットワークの中心部分へ向かう有向線部分 
３、有向線ネットワークの中心部分から出て行く有向線部分 

       ４、2 と 3 が中心部分を通らず直接つながっている部分 
       ５、1,2,3 を関係なく流れが出来ている部分（支流） 

０、まったく孤立している部分 
 
      有向線ネットワークは、巨視的に見ると以上のように流れがある。1,2,3 を本

流として捕らえ、1 を湖、4 は湖を通らない流れ、5 は支流、0 は沼と捉える

とわかりやすい。 
       
      では、実際どうなっているかを下記で見ていく。 
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中心部分 
1.LSSC 

図：2.IN 

2.IN 
 3.OUT 

2.INから3.OUTまでつな

がっているが明確な流れ

がない。 

図：1.SSCL 
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中心部分 
1.LSSC 

図：3.OUT 

1.LSSC 2.IN
 

3.OUT 

図：4.TUBES 
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1.LSSC 2.IN
 

3.OUT 

図：5.TENDRILS 

1.LSSC 3.OUT 2.IN 
 

図：0.OTHERS 
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図：Bow-Tie 後に生成された Partition ファイルで可視化したネットワーク 

 
 

<2-Mode 
2-Mode（2 部グラフ）ネットワークの 2 つの部分集合（First subset と Second 
Subset)をパーティションする 
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61B>Components 
    Components：ネットワークの最大サブグラフ（1 つ）である。 

2-mode ネット

ワーク（2 部グ

ラフ） 

2-mode の

Partition 

Firstsubset と 
Secondsubset Partition

を反映した

可視化 

図：Partition 2-mode 
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  入力項目 
  ①Component の最小サイズ 

Components：最大サブグラフ 
<Storng 
選択されたネットワークの「Storng Components」 

<Storng-Periodic 
 選択されたネットワークの「Storng-Periodic Components」 
強い結合の Components は、期間に従って分け進められる。 

<Weak 
 選択されたネットワークの「Weak Components」 
<Bi-Components 
選択されたネットワークの「Biconnected Components」 

         結合点(Articulation points)は、幾つかのクラスに所属している。その結果は、

Partition に記録されない。Biconnected Components は、Hierarchy に記録さ

れる。Components 内の頂点の最小値を選ぶ。それに加えて、Parititoin に属し

ている結合点が生成される。互いの頂点に属した Biconnected Components の

数が与えられる。Paritition は、正確な Biconponents の Paritition に所属して

いる頂点により成り立っており、Biconponents の外にある頂点と結合点は、共

に、以下のものが生み出される。 
Biconponents の外にある頂点：クラス番号 0 
Biconponents：クラス番号 1~ Biconponents の数と結合点はクラス番号

任意のネットワーク 

Pajek 
Component 

最大サブグラフ

(Component) 

<Storng 
<Storng-Periodic 
<Weak 
<Bi-Components 

*.clu 
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99999998 を取る。 
62B>Hierarchical Decomposition 

<Clustering 
階層的クラスター分類の手続き。入力は、異なるネットワーク（行列）で、そ

れは、Operation>Dissimilarity かインプットファイルを読み込むことによって

得られる。 
*Run 
階層的クラスター分類を作る。結果は、同種に集められた（nest された）

クラスターと、EPS に収められたデンドログラムを含む階層である。 
*Options 
階層的クラスターをつくる方法を選択する。 
（general,minimum,maximum,average,ward.squared ward） 

<Symmetric-Acyclic 
ネットワークの相対的非環分解。結果は、同種に集められた（nest された）

クラスターを含む階層である。 
 
63B>Numbering 
  Permutation に*.per ファイルが生成される。*.per ファイルは頂点の再配置（=頂点

番号の張替え）であり、Numbering とは頂点の再配置するメニューである。 

 

ネットワーク 

Numbering 
頂点の再配置 

ラインの張替え 

Permutation ファイル 
(*.per) 

対象ネットワーク

の頂点再配置 

再配置され

たネットワ

ーク 

図：numberring の処理手順 
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<Depth First 
Depth first numbering of selected network 

*Strong 
taking directions of arcs into account 
有向線の方向を計算する 

*Weak 
forget directions(or undirected network) 
 方向を考慮しない。つまり、無向線向け処理。 

<Breadth First 
Breadth=幅、広さ 
Breadth first numbering of selected network 

*Strong 
taking directions of arcs into account 
有向線の方向を計算する 

*Weak 
forget directions(or undirected network) 

<Reverse Cuthill-McKee 
RCM numbering=? 

<Core+Degree 
64B>Citation Weights 

Citation=引用 
 もしも、ネットワークが Citation network として表せるなら、ラインの値（重み）

（つまり、Citation）と頂点（の一部）は以下を出力とした計算ができる。 
 ラインの値（重み）：Citation 
 結果は、 
  ⅰ）重要な Citation で表されたラインの値（重み）のついたネットワーク 
  ⅱ）メインパス上の頂点による Binary(0 か 1)Partition 
  ⅲ）メインパスのみにより構成されたネットワーク 
  ⅳ）重要な頂点（の一部）の Vector 

重さは、標準化（使用されている流れか最大値）またはログをとることも出来る。 
<Search Path count(SPC)  
 非環状ネットワークでないと処理できない。水源から排水溝への計算を行う方

法。 
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Path とは以下のように直線上につながったものである。 

 
<Search Path Link count(SPLC) 
  互いの頂点を水源として考慮した方法。 
<Search Path Node pair(SPNP) 

method. 
65B>k-neighbors 
 対象頂点（自分で選んだ）から最大ステップを指定し、どこまでの頂点までいけるか？ 
がわかる。 
k-neighbors を選択した後の手順 
 ①対象頂点を選ぶ 
 ②最大ステップ数（k-step）を選択する 
 ③メインスクリーン Partition ボックスに*.vec が生成 
 ④Partition と共に可視化（Draw>Draw-Partition） 
 ⑤下図のような可視化が出来る 

図：Path 

 

環状になってい

る 。 非 環 状

（acyclic）ネット

ワークでない。 

図：環状ネットワーク 

Kamada-kawai
最適化による可

視化。（他の可視

化のときは環状

かどうかわかり

にくい。 
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図：頂点 2（水色）から 4 ステップ（最大値）でいける頂点 
  1 ステップでいける－黄色 
  2－ステップでいける－黄緑 
  3－ステップでいける－赤 
  4－ステップでいける－青 
  この配色は、Partition の色別設定に従う。 
  Options>Colors>partition Colors>for vertices 
    で変更可能 
  可視化のとき、ctrl＋N を押せば頂点番号、ctrl＋L を押せばラベルが表示されて、 
  どの頂点まで到達するかがわかる。 
  （Options>Make Vertices Using） 

k-neighbors： 
Select All vertices… 

<Input 
最大 k-step の選ばれた頂点に届くことが出来る入次数の頂点を探す。 

..form which we can reach selected vertex in at most k-steps 
<Output 

最大 k-step の選ばれた頂点に届くことが出来る出次数の頂点を探す。 
..that can be reached form selected vertex in at most k-steps 
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<All 
..Input+output 

<From Clusters 
計算は、選ばれた距離に従ったクラスター内の互いの頂点距離となる 
 

66B>Paths between 2 vertices 
2 頂点間のパスに関して・・・ 

<One Shortest 
2 頂点間の最短パスを求める。 
入力項目 

① From 
② To 
③ Forget value of lines?(yes/no) 
④ Identity vertices in source of network 

 

図：頂点番号 30 から 50 までの最短パス。 
番号は、パス数である。新しいネットワークファイルとなっているため、Darw のみでは、

どの頂点を通っているかはわからない。しかし、元のネットワークファイルと生成された

Partition ファイルを使って可視化すればどの頂点を通って最短パスを形成しているかがわ

かる。 
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図：元ネットワーク内の 30 から 120 までの経路（黄色） 

 

<All shortest 
すべての 2 頂点間の最短パスを求める。 

<walks with Limited Length 

 

30 

120

図：元ネットワーク内の 30 から 120 までの経路（黄色）kamada-kawai 最適化 
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最長レンジを探す。 
入力項目 
① From 
② To 
③ Forget value of lines?(yes/no) 
④ Identity vertices in source of network 
⑤ Input maximum length of walk allowed(>0) 

 
<Diameter 

Diameter を探す 
Diameter：直径 
最長最短パスを探す 
Diameter：最長最短パス? 

<Geodesics Matrices 
small network のみの処理！ 
Geodesics：測地線 ・最短パス長のこと 
最短パスのマトリックスを計算する 
そして測地線を計算したマトリックスを計算する 

<Distribution of Distances 
*From All Vertices 

starting points のすべての頂点を取る 
starting points： 

*From Vertices in Cluster 
クラスター内の頂点のみ 

 
67B>Critical Path Method(CPM) 

非環ネットワークでクリティカルパスを求める。結果は、クリティカルパスを含んだ

新しいネットワークとなる。2 つの Vector ファイル（及び Partition ファイル）を生成

する。1 つ目のファイルは、早い時間の状態が記述され、2 つ目のファイルは、遅い時

間の状態が記述される。 
68B>Maximum Flow 

Maximum Flow amang vertices 
複数の頂点について最大フローを求める 

<Selected Pair 
2 頂点の最大フローを求める。（アルゴリズムは、直線のパスとそれらの周りの

いつも選ばれる最短のパスを探す。）アルゴリズムは、テクニカルエリア（実際



 96

のフロー[actual flow]、許容量を意味するラインの値（重み））あるいは、分析

的グラフ（すべてのラインが 1 のとき）を使う。 
 入力手順 

① Find  maximum flow の from の入力 
② Find  maximum flow の to の入力 
③ Forget values in lines?（ラインの値（重み）を忘れるか？） 
④ Identify vertices in source network?（頂点を元のネットワークと見分         

                     けるか？） 

 
図：30 から 60 の Selected Pair の Maximum Flow の例(15 頂点、Flow=1.00000) 
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図：元ネットワーク内での 30 から 60 の Selected Pair の Maximum Flow 
        
       生成されるもの 
       ⅰ）新しいネットワーク（*.net ファイル） 
       ⅱ）Partition ファイル 

 
<Pairs in Cluster 
頂点の周りで定義されたクラスター間の最大フローを求める。結果で生成され

るものは、ラインの値（重み）の意味が、一致した 2 頂点間の最大フローであ

る新しいネットワークである。 
     （アルゴリズムが遅いため、限定的な頂点の小さなネットワークのみである。） 

69B>Vector 
get vector from network 
*.vec ファイルを生成する操作（オペレーション）メニュー 

<Centrality 
中心性を求める。 
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中心性とは 

      中心性（Centrality）とは、ネットワーク分析のための概念であり、ネットワ

ーク内の任意の頂点がどれだけ中心にあるかの性質を示す概念である。その量

的な指標を中心性指標という。 
 
     中心性指標には大別して 4 つが存在する。 

１、次数：ある頂点が所有している次数に着目し、次数が大きいほど中心性

が高い 
２、近接性：ほかの頂点とどれだけ距離が離れているかを示すもので、これ

が小さいほど中心性が高い 
３、媒介性：その頂点を通過しないと到達できない頂点の数を表し、その数

が大きいほど中心性が高い 
４、固有ベクトル：どの程度ほかの頂点とつながっているかを示す。 

 
       Pajek では、「2、近接中心性（Closeeness Centrality）」と「３、媒介中心

性（Betweenness Centrality）」を求めるメニューがある。この中心性を可

.Net 
中心性 

Vector>Centrality 

.Vec 

可視化 
Draw-Vector 

 

各頂点の中心性を計算し

たデータが入っている。 

各頂点の中心性を

反映した可視化 

図：中心性 
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視化も出来る。 
１、次数中心性（Degree Centrality） 

          （pajek のメニューに存在する。） 

次数中心性 )( id vC 、頂点 iv 、頂点 iv と隣接する頂点の次数 )deg( iv  

ネットワーク総頂点数 N とすると、 

1
)deg(

)(
−

=
N

v
vC i

id  

任意の頂点の近接する頂点数（次数）と自身の頂点を除いた総頂点数の

比で表される。 
 
ある頂点の次数が高いほど、次数中心性が高い。つまり、次数中心性は

ハブ（あるいは、オーソリティ）に近い役割を果たす頂点を探すことで

ある。 

 

 
２、近接中心性(Closenness Centrality) 

頂点 iv 、頂点 iv の近接中心性 )( ivCc 、ほかの頂点までの距離の総和（離

心率） )( ivs とすると、 

)(
1

1
)(

)(
i

i
i vs

n
n

vs
vCc −

=⎟
⎠
⎞

⎜
⎝
⎛

−
=

－１

 

次数中心性が高い（ハブ・オーソリティに近い） 

図：次数中心性とハブ・オーソリティ 
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離心率が高くなるほど )( ivCc が小さくなり、中心性が高くなる。離

心率 e を他の頂点までの距離総和 )( ivs とする。 

 evs i =)(  

          つまり、定数 )( ivs という離心率の描き出す図は楕円である。 

 
 
 
 
 
 
 
 
 
 

 
図：離心率[10] 

離心率 e の描く図形とは、図 1.1 の 定数）(e
PH
PF

= を満たすの図形

のことであり、離心率=0 は円で 0<e<1 は楕円である。つまり、円

より楕円のほうが面積が大きいので、離心率が大きいとほかの頂

点までの距離の総和が大きいと考えられる。 
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近接中心性には、以下の式も存在する。 
ある集団（コミュニティー）の総頂点数ｇ、ネットワーク内の

任意の頂点 in 、 in と同じコミュニティー内の任意頂点 jn  

in と jn の最短距離 ),( ji nnd 、中心性指標 )( inCc とすると、 

1

1

),()(
−

=
⎥
⎦

⎤
⎢
⎣

⎡
= ∑

g

j
jii nndnCc  

焦点を対象頂点と考えると、離心率の大

きい楕円ほど、他の頂点の距離の総和が

大きいとみなす。総和が大きいほど離れ

ている 

媒介中心性：大 媒介中心性：小 

図：離心率と媒介中心性 

円は焦点がない。つま

り、離心率 0。それは、

他の頂点距離総和が0と
同じである。 
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この式は、他の頂点までの距離の総和（離心率）ではなく、任

意頂点の最短距離から近接中心性を求める式である。式からわ

かるように、任意の頂点 in とその頂点のコミュニティー内の頂

点 jn の最短距離をコミュニティー内の全頂点で計測していく。

その数が小さい（つまりほかの頂点との距離が近い）と )( inCc が

大きくなって、その頂点は中心性が大きくなる。g は、ネットワ

jn

in

),( ji nnd

最短経路でない。 

最短経路 

図：最短経路 ),( ji nnd  

jn  
jn

jn  

in  

in
in  

最短経路が短いほど近接中心性が高い 

図：最短経路と近接中心性 
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ークの頂点数で、∑
g

全頂点で計算するという意味である。前

の式との違いは、前の式は対象頂点と別の頂点の距離の総和に

着目したが、この式は最短距離に着目するという違いである。 
 

３、媒介中心性（Betweennes Centrality） 

              （pajek のメニューに存在する。） 

 

また、ハブ・オーソリティのような頂点も、潰れてしまうと迂

回路を通り Walk に大きなパス数を使う可能性が高くなるため、

これらの頂点も媒介中心性が高くなる。つまり、最短パスの順

路はハブ・オーソリティの数や集中度が高いほど、これらを通

る確率は必然的に高くなるから、これらの媒介中心度は高くな

る。 

頂点とリンク

の密集地 

このショートカットが潰れてし

まうと、迂回し Walk に大きなパ

ス数を使わないといけない。 
つまり媒介中心性が高い。 

図：媒介中心性の高い頂点の特徴(その 1) 

ショートカット 
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            上記から「次数中心性」との違いは明確で、媒介中心性の高い

頂点の特徴(その 1)より、次数中心性では考慮されなかった「ブ

リッジ」も中心度が高くなる。 

媒介中心性 )( kij vCb 、頂点 kv が各 2 頂点 iv と jv 間の最短経路上

に存在する（媒介する）頻度 )( kij vb 、ネットワーク総頂点（ノ

ード）n の２頂点間のうち )( kij vb の合計値 、媒介値 )( kvBC と

すると、 

C
)1)(2(

)(2
)(

−−
=

nn
vBC

vb k
kij  

 

この式は、総頂点 n から 2 頂点 iv と jv を除いたものと、総頂

点nから頂点 kv を除いたものの積と媒介値の 2倍数 )(2 kvBC

の比によって表される。 

ハブが潰れることは、最短パスが潰

れることになる可能性が高い。 
よって、媒介中心性が高い。 

ハブが潰れたら、このパス

のような大きいパス数の

迂回路を使うことになる。 

Start 

Goal

図：媒介中心性の高い頂点の特徴(その 2) 
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媒介中心性を他の表現をすると、 
ノード i、媒介中心性 Cb(i)、i を通るｊ、ｋ間の最短経路の数

)(ig jk 、ｊ、ｋ間の最短経路の総数 jkg 、ネットワークの総ノ

ード数 N とると、 

)1(
2
1

/)(
)(

−
=
∑ <

NN

gig
iCb

jkjkkj
 

 
（ネットワーク上に存在するノードペアの最短経路がどの程

度ノード i を経過しているかの比で表現される（2004，松

田）) 

この式は、 )( kij vCb の式とは違い、媒介ノードを特定せずに、

2 ノード間の最短経路でいくつのノードを経過するかを計

ることによって媒介中心性を求めている。 
 

４、固有ベクトル中心性 
以下の、ボナチッチ中心性（Bonacich Centrality）は、固

有ベクトル中心性の代表的な手法である。 

頂点 iv 、頂点 iv が jv を指名する結合強度 ijr 、頂点 iv の中心

性 iC 、頂点 jv の中心性 jC 、定数λ  

頂点 iv の中心性 iC は、 iv が ijr の強さで結合する頂点 jv の中

心性 jC に依存する。 

λ
∑= jij

i

Cr
C  

 
多くの頂点とつながっている中心性の高い頂点との連結

が、中心性を高くするという考え方で、数学的には隣接

行列 [ ]ijr を求めていることの他ならない．(2006，中村) 
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そのほかに、ポータルサイトのページランクのアルゴリズ 

ムも、固有ベクトルによって、中心性を求める。以下のも

のが有名である。       
・HITS アルゴリズム(1998，Kleinberg) 

・PageRank アルゴリズム(1998，Brin & Page) 
 

*Closeness 
クロースネス中心性を求める 

1.Input 
2.Output 
3.All 

*Betweenness 
 媒介（Betweenness）中心性 

<Get Loops 
ループベクトルを保存する。 

 

<Get Coordinate 
x か y か z の Coordinate を取得する。一回ですべての Coordinate を取得する

ことも出来る。 
      *x 

*Arcs 
       1        2 1  
       1        1 1 
       2        2 1 
       2        3 1  
       2        5 1  
       3        4 1  
       3        8 1  
       5        6 1  
       5        7 1 

Get Loops 

ループのある頂点を Vector：
1 へ、それ以外は 0 へ 

図：Get Loops 

Vector ファイル 



 107

       x の Coordinate 
      *y 
       y の Coordinate 
      *z 
       z の Coordinate 
      *ALL 
       すべての Coordinate 

 
図：x の Coordinate の例 

 

<Important Vertices 
重要な頂点を見つける。 

*1-Mode:Hubs/Autorities 
1-mode ネットワークのハブやオーソリティを見つける 
ハブ：有向線グラフにおいて、出次数が他の頂点と比べて圧倒的に大きい

もの 
オーソリティ：有向線グラフにおいて、入次数が他の頂点と比べて圧倒的

に大きいもの 
オーソリティとハブのネットワーク内の意味は、 

・ハブやオーソリティへの次数が高い（集中度が高い） 
・ネットワーク内のハブやオーソリティの数が多い 

図：x の Coordinate の例 

Vwctor ファ

イル 
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ほど、ネットワークの平均パス数は大幅に減少し、伝播しやすくなり、つ

まり小さい世界（ネットワーク）になる。 
 

 

無向線の場合は、入次数・出次数の区別なく、主にエッジが集中し

ている頂点はハブといっている。つまり、有向線のときのみ、オー

ソリティとハブと区別する。 

 
       入力項目 
        ①How many hubs（ハブの数） 
        ②How many authorities(オーソリティの数) 
       以上の入力項目に従い、そのネットワークで定義されたハブ・オーソリテ

ィの数に従い、それらを探す。 
 
      出力は、Pertition：ハブやオーソリティとその他のノードのクラス分けと、

vector：ハブやオーソリティの度合いの計算結果の 2 つが出力される。 
 

*2-Mode:Important Vertices 

オーソリ

ティ 
ハブ 

図：オーソリティとハブ 

ハブ 

図：ハブ（無向線グラフのとき） 
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最初の部分集合（Fiest subset）と 2 つ目の部分集合(Second subset) 
の重要頂点を求める。 
入力項目 
① How many important vertices from first subset 
     (First subset からの重要頂点の数) 
② How many important vertices from first subset 
  (Second subset からの重要頂点の数) 

<Structural Holes 
burt's measure of constraint(structural holes) 
constraint=強制・制約（条件） 
burt's measure of constrain=バーツ値制約条件 
Structural Holes=構造の穴（複数） 
Vector ファイルが生成される。 

Network ijP ：クラス番号 i とすべての i の関係の数と比較した i と関係ある j 

ija
：i から j へのラインの値（重さ） 

∑ +

+
=

k kiik

ijij
ij aa

aa
p

)(
 

 

ネットワークに属していてる 2 項制約条件（dyadic constraint） ijC ： 

制約条件は、i 上の j 周りの 1 項の穴（Primary hole）が不在である。 
     接点（contact）j は、あなたの i の以下の企業家の意見の範囲で制約されている。 

a) あなたはエネルギーが j に届き、時間の大きな投資を作られた。 
b) j はいくつかの投資に対する優位なリターン（黒字）をとるための交渉が出

来ることがついたいくつかの Structural Holes（構造の穴）囲まれている。 

   ∑
≠≠

+=
jkikk

kjifijij PPPC
,,

2)(  

 

Vector は制約 iC の総量から成り立っている。 

∑= j iji cC  

孤立頂点は、 
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1=iC  

 

図：Structural Holes 
 

 
<Clustering Coefficients 

Clustering Coefficients：クラスタリング係数 
クラスタリング係数を計算する。（無向線ネットワークの） 
無向線ネットワーク内にある違う固有の傾向の係数を計算する。 

)deg(v ：頂点の v の次数 

)(( 1 vGE ：頂点 v の 1-近隣（1-neighborhood）内にある頂点（vertices）の周

りのラインの値（重さ） 

)(( 2 vGE ：頂点 v の 1 および 2-近隣（1-neighborhood）内にある頂点（vertices）

の周りのラインの値（重さ） 
     * 1CC  
        1-近隣（1-neighborhood）のみを考慮した係数 

       
)1)(deg()deg(

))((2
)( 1

1 −
=

vv
vGE

vCC
・
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       )()deg()( 11 vCC
MaxDeg

vvCC =′  

       
* 2CC  
 2-近隣（1-neighborhood）を考慮した係数 

))((
))((

)(
2

1
2 vGE

vGE
vCC =  

)()deg()( 22 vCC
MaxDeg

vvCC =′  

 
もし、 1)deg( ≤v ならすべての頂点 v の係数(Coefficients)は 0 になる。 

 
Vector と Partition ファイルが生成される。 

<Summing up Values of Lines 
頂点のつながったラインの入力出力をの合計値を出す。 

 

生成されるファイルは Vector のみ。（Partition は生成されない） 
      *Input 
      *Output 
      *All 

3 

2 

3 

1

2 

Input 
合計値：5 

Output 
合計値：6 

図：Summing up Values of Lines の処理 
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       Input+ Output 
 

<Min of Valuesof Lines 
頂点のつながったラインの入力出力をの最小値を出す。 

 
生成されるファイルは Vector のみ。（Partition は生成されない） 

      *Input 
      *Output 
      *All 
       Input+ Output 

 
<Max of Values of Lines 
頂点のつながったラインの入力出力をの最大値を出す。 

3 

2 

3 

1

2 

Input 
最小値：2 

Output 
最小値：1 

図：Min of Valuesof Lines の処理 
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生成されるファイルは Vector のみ。（Partition は生成されない） 

      *Input 
      *Output 
      *All 
       Input+ Output 

 
<Centers 

robbery アルゴリズムに従い centers を求める。頂点は（vertices）それらから

盗まれたそれらの近隣より高い次数を持つ。 
Centers： 
はじめのとき、初めの濃度を頂点へと与えるときは、それらの頂点か値 1 での

始まりに従う。 
弱い頂点を見つけたときは、近隣はそれらの濃度に従ったから盗む、あるいは、

それらは、同じ合計値から盗む。 
 

3 

2 

3 

1

2 

Input 
最大値：3 

Output 
最大値：3 

図：Max of Valuesof Lines の処理 
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聞いてくること 
① Start with weighted values(degrees of vertices)? 
② Use weighted algorithm? 

 
図：Center を求めた後の可視化 

 

弱い頂点（次数の少な

い）からセンターへと

次数の移動 

図：Center 生成の概念図 
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<Pcore 
コアを求める。 
core=k-core+m-core 
m-core=それぞれの線が m 以上の多重性を持つ最大サブグラフのこと 

*Degree 
ordinary cores 
普通のコア。 

 
図：Core All 

 1. Input 
   入次数 
 2. Output 
   出次数 
  3. All 
   無向線 
  4. Input+Output 
   入次数と出次数との合算 
  5. Max(input,output) 
   入次数と出次数の最大値 

*Sum 
 ラインの値（重み）を考慮に入れる。（Pcore の内側にあるラインの値（重

み）を合計する。） 
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 1. Input 
  入次数 
2. Output 
  出次数 

 3. All 
   無向線 
4. Max(input,output) 
  入次数と出次数の最大値 

*Max 
ラインの値（重み）を考慮に入れる。（Pcore の内側にあるラインの値（重

み）の最大値をとる。） 
  1. Input 
 2. Output 
  3. All 

 
 

70B>Count 
定義済み（pridefined)のリングに線がどれくらい属しているか 

<3-Rings 
3-ring の定義済みリングにどれだけ属しているか。*.net ファイルが変更される。 

      

図：ラインが Cyclic か transitive（Shortcut）の 3-rings に属している[mamu] 
*Undirected 
  無向線ネットワークの 3-ring の抽出。有向線ネットワークの 3-ring と違

い、3 頂点にリング状にラインがリンクされているものが、無向線の

3-ring である。 
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*Directed 

        無向線ネットワークの 3-ring の抽出。 
<4-Rings 

3-ring の定義済みリングにどれだけ属しているか。*.net ファイルが変更される。 

            
           図：4-rings 上の有向線の種類[manu] 

*Undirected 
 無向線ネットワークの 4-ring の抽出。有向線ネットワークの 4-ring と違い、

4 頂点にリング状にラインがリンクされているものが、無向線の 4-ring で

ある。 

図：Undirected の 3-ring の例 

3-ring 上に重みが付けられ、灰色

のラインで 3-ring が可視化され

ていることがわかる。 

図：無向線ネットワーク(Undirected)の 3-ring 
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*Directed 
       有向線ネットワークの 4-ring の抽出。 
 
      ちなみに、ring には以下のような種類がある。ただ、3-ring と 4-ring が一般

的で、Pajek でもこの 2 種のみカウントできる。 

図：無向線ネットワーク(Undirected)の 4-ring 

可視化の

違いのみ

でこれも

4-ring 

図：Undirected の 4-ring の例 

4-ring 上に重みが付けられ、灰色

のラインで 4-ring が可視化され

ていることがわかる。 
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13B3.3Nets 

２つのネットワークに関する処理。 
1 つ目(Main)のネットワークを『First network』といい、 
2 つ目のネットワークを『Second network』という。 
主に、Second network を First network に追加するという処理である。 

 

 

71B>Union of lines 
2 ネットワークのラインを統合する 

3-ring 4-ring 

図：3-ring から 5-ring の可視化 

5-ring 

 

First network を入れるボックス 

Second network を入れるボックス 

図：2 つのネットワークとメインスクリーンのボックスの関係 
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72B>Cross-Intersection 

選ばれた２ネットワークの交差させる 
73B>Intersection 

選ばれた 2 ネットワークを関係する数字のところで交差させる 
74B>Cross-Differnce 

選ばれた異なったネットワークを交差させる 
75B>Defference 

異なったネットワークのラインを引く。Union of lines と逆の操作。 
76B>Union of Vertices 

頂点を統合する 
77B>Fragment(1 in 2) 
   2-mode ネットワークないで（1-mode ネットワークによって定義された）すべての

種類の断片を見つける。 
<Find 

 

Union of lines

図：Union of lines 

右のネットワ

ークのライン

（青）が左の

ネットワーク

（黒）へ合成

される。 
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 コマンドを実行する。 
<Options 

適当な断片モデルを選ぶ。 
*Induced 

         
*Labeled 
ラベルに一番合うもの 

*Check Values of lines 
*Check relaton number 
*Extra subnetwork 
サブネットワークの頂点は特定の断片やに含まれるかあるいは一致する

か？ 
・Retain all vertices after extracting 

*Same vertices determine one fragment at most 
同じ頂点の集合のどの断片として扱えるか？ 

*Repeating vertices in fragment allowed 
 
78B>Multiply First*Second  

選択された 1-mode か 2-mode のネットワークを増やす。 
     選択された 1-mode や 2-mode は Second network のこと 

79B>Shrink coordinates(1to2) 
<Partiotion 
<Hierarchy 

 

14B3.4Operetions 
one network and something else is needed as input 

80B>Shrink Network 
Shrink Network=縮むネットワーク？ 
ネットワークを縮ませるオペレーション？ 
Shrink Network=ネットワークの種類（IN Bolockmodel?) 

<partition 
<hierarchy 

81B>Extract from Network 
  サブネットワークを以下の対象から引き出す処理 

<Partition 
サブネットワークを Partition に従い引き出す。（Partition のクラスの range を
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引き出す。） 
 

    Partition ファイル(*.clu)ファイルがあらかじめないと、処理を受け付けない。 
     入力数字 

① クラス番号 
このクラス番号のネットワークをサブネットワークとして抽出する。 

 
    処理のアウトプット 
     ①*.net に生成されたサブネットワークが入る 
     ②*.clu には、選択されたクラス番号のみの Partition が入る 

<Cluster 
 選択されたクラスターからサブネットワークを引き出す。 
<to GEDCOM 
 新しい GEDCOM ファイルに選択された Parition（Weakly connected 

component）から生成された、サブ系図(sub-genealogy)を入れる。 
82B>Brokerage Roles 
   partition ファイルが必要 
 Brokerage：仲買、仲介 
 Brokerage Roles： 

 
図：Brokerage Roles[Reference Manual] 

 
 処理すると、以上の 5 種類の Brokerage Roles の Partition ファイルが 5 つ生成される。 
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83B>Dissimilarity 
    Dissimilarity：差異性（=類似性） 
    共通の近隣の値にしたがったクラスター内の頂点間の選択された Dissimilarity 

Matrix－つまり類似性行列（ 4321 ,,, dddd ）を計算する。Corected Euclidean-like 

5d Manhattan-like 6d の類似性も同様に計算する。 

   
  頂点が入っているクラスターファイル(*.cls)が必要。 
 

vN ：入次数、出次数あるいは普通の次数（入出無関係の次数）の近隣の頂点 v の集合 

＋：システム的加算 
∪：和集合 
\ ：差集合 
｜：集合の濃度 
1st maxdgree,2nd maxdegree：最大次数と 2 番目の最大次数 
頂点 v のそれ自身の近隣を含めるか含めないか、また、（もし、頂点の値が低いなら）

Upper triagle（無向線ネットワーク）か完全行列（有向線ネットワーク）をレポート

ウインドウに表示できる。 
 

Corected Euclidean-like 5d Manhattan-like 6d は、いくつかの頂点上の行列 ][ uvqQ =  

からなっている。たとえば、隣接行列や距離行列など。パラメーターq はたいてい 1 か

２の値の集合である。 0== vu NN の時は、すべての類似性行列（ 4321 ,,, dddd ）は

5 種 類 の Brokerage 
Rolesの5つのPartition
ファイルが生成 
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1 となる。 

 
    <d1 

1. Input 
2. Output 

       3. All 
 

 
図：Dissimilarity d1 処理後のレポート 
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<d2 

1. Input 
2. Output 

       3. All 

       1 
       2 
       3 
       4 
       5 
  ・・・（中略）・・・

      20 

 

d1 の計算と

可視化 

頂 点 数 20 の

Complete クラスタ

ー

図：Dissimilarity の d1 処理過程 
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        <d3 
1. Input 
2. Output 

       3. All 
        <d4 

1. Input 
2. Output 

       3. All 
        <d5-corrected Euclidean 
        <d6-corrected Manhattan 
        <Option 
84B>Vector 
    ネットワークと Vector に関する処理。 

<Network*vector 
 普通の Vector の行列（ネットワーク）の掛け算。結果は、新しい Vector である。 
  入力手順 
   ①Number of repetition（反復回数） 
<Vector#Network 
 結果は、新しいネットワークである。 

*Input 
 Vector の値と一致するネットワーク内の入有向線の掛け算。 
 i 次（i-th）の Vector のコンポーネントと i 次(i-th)の行列の列を掛ける。 
*Output 
 Vector の値と一致するネットワーク内の出有向線の掛け算。 
 i 次（i-th）の Vector のコンポーネントと i 次(i-th)の行列の行を掛ける。 

<Harmonic Function 
 Harmonic Function：同調関数 
 ),( aG ：重さ関数（Weight functioin） ),( yxa を持った結合した重さグラフ 
     （Connected weighted graph） 
  S：頂点 )(GV の部分集合 
 もし、 

 ∑=
y

yfyxa
xA

xf ))(),((
)(

1)(  

 SGVx \)(∈∀  

 ∑=
y

yxaxA ),()( なら 
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関数 RgVf →)(: は、境界(Boundary)S を持つ(G,a)上の同調(Harmonic)とい

う。 
 
Pajek では以下を実行する。 
・関数 f は Vector によって定義づけられる。 
・重さ関数 ),( aG は、（数値化された）ネットワークによって与えられる。 
・部分集合 S は、Partiiton によって定義づけられる。クラス 1 の頂点は、（頂

点と合う）部分集合 S に入れられ、他の頂点は SGV \)( に入れられる。 
・追加的に、Permutattion はコンピュータ上の頂点のオーダーによって定義づ

けられる。 
*Input 
 入力近隣 
*Output 
 出力近隣 
*All 
 入力出力を区別しない近隣 

<Summing up neighbors 
*Input 
*Output 
*All 

<Min of neighbors 
*Input 
*Output 
*All 

<Max of neighbors 
*Input 
*Output 
*All 

<Put Loops 
<Put Coordinate 
<Diffusion Partition 
<Islands 

*Vertex Weights 
*Vertex Weights[simple] 
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85B>Transform 
    ネットワークを、Partition、Cluster、Vector に従い変形させる。以下のようなコマ

ンドによって変形させる。 
<Remove Lines 
 Partition（*.clu）に従い、ラインを消去する。 

*Inside Clusters 
 選択された同じクラスター内の頂点のラインを消去する。 

 

*Between Clusters 
 異なったクラスター間の頂点のラインを消去する。 

クラスター 
 クラス 

ター 

クラスター 
 

Partition 
(*.cls) 

Partition（ク

ラスター）は

*.cls で定義

される。 

選択されたクラスターの

頂点のラインの消去 

User の消去したいクラスターの選択 

図：Remove Lines *Inside Clusters 
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*Inside Clusters with value 

1.lower than Vector value 
2.higher than vertor value 

<Add 
*Arcs from Vertex to Cluster 
*Arcs from Cluster to Vertex 

<Direction 
*Lower->Higher 
*Higher->Lower 

<Vector(s)->Line values 
 
86B>Reorder 
   再配列(Reorder)する。再配置には、Permutation ファイル（*.per）を使用する。 

クラスター 
 クラス 

ター 
Partition 

(*.cls) 

Partition（ク

ラスター）は

*.cls で定義

される。 

図：Remove Lines * Between Clusters 

クラスター 
 

クラスターの間の頂点の

ラインの消去 
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図：*.per のメインスクリーンの Edit の表示の例 

頂点１は頂点 102 へ、頂点２は頂点 35 へ再配置される。 
<Network 
 Network(*.net)ファイルの頂点を、選ばれた Permutation に従い再配置する。 
<Pertition 
 Partition(*clu)ファイルの頂点を、選ばれた Permutation に従い再配置する。 
<Vector 

     Vector(*.vec)ファイルの頂点を、選ばれた Permutation に従い再配置する。 
87B>Count neighbor Colors 
      Partition と Cluster が必要。選ばれたネットワークと Partition のための新しい

Parititon を、近隣の選ばれた色を与えた頂点の確率的な互いの頂点のところに生成

する。色は、定義されたクラスターファイルにより計算される。 
88B>Coloring 

<Create New 
  Permutation（頂点の再配置のためのファイル）によって秩序付けて定義され

た頂点の『経過的な』色付け。Paermutation ファイルが結果に依存する割合

はかなり高い。 
<Complete Old 
  Permutation（頂点の再配置のためのファイル）によって秩序付けて定義され

た頂点の『完全な』色付け。例えば、手によって幾つかの頂点が色づけされ
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たとしても、大半の頂点はいまだに色づけされていない頂点である。（クラス

0）。この方法は、適当な色分けを支援してくれるコマンドである。 
89B>Balance 

   符号付のグラフ Partition を行うためのアルゴリズム。（+、－のラインの値（重み）

は、友と敵を表す。）ハイダーのバランスモデルのことである。 
    3 者間の関係を+（よい）－（悪い）で表した図のモデル。－の悪い関係が偶数の

とき、バランス（均衡）し、奇数のときは均衡が崩れ均衡しようとするモデル。 

 

     この 3 角形を基本として、大きなネットワークを形成させることも出来る。 
90B>Blockmodeling 
  ブロックモデルを生成する 

<Randam start 
 ランダム Partition による最適化を始める 

犬 

花子 
太郎 

＋ 
＋ 

花子さんは犬

が好き 
太郎くんは犬

が好き 

－ 

－が奇数でアンバラ

ンス。犬を－（嫌い）

に出来ないとする

と。 

太郎くんと花

子さんは嫌い

あっている。 

均衡させ

る。 

＋ 
太郎くんと花

子さんは好き

あっている。 

図：ハイダーのモデル例 



 132

  

<Optimize Patition 
 選ばれた Partition やその最適化の（判断）基準を表示する。 
<Restricted Options 

      
91B>Genetic Structure 
 与えられたPartitionに従った、与えられた非環状ネットワークの発生の構造を計算する。 
 
92B>Permutation 
  与えられた Permutation をネットワークに従い改善する。 

<Travelling Salesman 
*Rum 
*Options 

<Seriaton 
*1-mode 
*2-mode 

<Clumping 
*1-mode 
*2-mode 

<R-Enumeration 
93B>Functional Composition 
  ｆ：partition か permutation 

g：partition か permutation か vector 
     r：r=(f＊g)[v]=g[f[v]] によって生成された partition か permutation か vector 

94B>Expand Parition 
<Greedy Partition 
  頂点と共に不明なクラスを 0 と置く。 

*Input 
*Output 
*All 

<Influencce Partition 
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<Make Multiple Relations Network 
95B>Expand Reduction 
  階層による削減によって削減されたネットワークと適当な階層（いつも無向ネットワ

ーク）を再記録する。 
96B>Identify 
  Identify(reorder and/or join some units) 
97B>Petri 
    ペトリネットを生成する。Partition ファイルが生成される。 
  ペトリネット：コンピュータの並列処理を表すモデル図 

 

図：Petri net[manual] 
<Random 
<Complete 

98B>Refine Partition 
Refine：精製［錬］する, 純化する ; 洗練する、改善する 
選ばれたネットワークに従い Partition を改善する。 

<Strong 
 有向ネットワーク 
<Weak 
 無向ネットワーク 

99B>Leader Partition 
   層のかなにあるネットワークの頂点のクラスターを見つける。 
   層・階層（layer）： 
   Leader：指導者、指揮者、【コンピュータ】先行部分、【印】（pl.） リーダー ((点線

や破線)); 導管 
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15B3.5Partition 
100B>Create Null Partition 
  頂点数を定義（Dimension）して、Null Partition を生成する。Null Partition とは、

クラス番号がすべて 0 の Partition である。 
101B> Create Random Partition 
  頂点数とクラス数を定義（Dimension）して、Random Partition を生成する。Random 

Partition とは、クラス番号がすべて Random に割り振られた Partition である。 
102B>Binarize 
  選ばれた Partition(*.clu)を Binary（0 か 1）の Partition にする。選択されたクラス番

号を 1 に選択されなかったものをすべて 0 にする。よって、このメニューを実行する

前に、Partition(*.clu)が Partition ボックスに入っていなければならない。 
   

 

    特定のクラス番号のクラスターを抽出することが出来る。 
103B>Fuse Clusters 
  選ばれた Partition(*.clu)の選択されたのクラス番号を、別のクラス番号にする。 
 

*Vertices 327 
4 
4 
2 
1 
2 
4 
4 
3 
5 
1

*Vertices 327 
0 
0 
1 
0 
1 
0 
0 
0 
0 

図：Partition> Binarize の処理 

Select cluster 
「２」 
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104B>Canonical Partition 
  Partition から特徴的な（Canonical）Partition を生成する。特徴的な Partition のル

ールは、 
  1)頂点 1 はクラス（番号）１ 
  2)頂点 1 のクラスより次の頂点が小さい数ならば、頂点 1 はクラス（番号）２へ 
  3)繰り返す 

105B>Canonical Partition[Decreasing frequencies] 
   Partition から特徴的な（Canonical）Partition を生成する。特徴的な Partition の

ルールは、 
  1)クラス１は最大頻度の集合の古いクラス 
  2)クラス 2 は 2 番目の頻度の集合の古いクラス 
  3)繰り返す 
106B>Make Network 
   選ばれた Partition によるネットワーク生成。 

<Random Network 
*Undirected 
*Input 
*Output 

<2-mode network 
107B>Make Permutation 
   選ばれた Partition による Permutation 生成。 

*Vertices 327 
2 
3 
2 
5 
3 
5 
4 
1 
4 
5

*Vertices 327 
7 
3 
7 
5 
3 
5 
4 
1 
4 

図：Partition> Fuse Clusters の処理 

Select cluster 
「２」 

New cluster number
「７」 
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108B>Make Cluster 
   選ばれた Partition による Cluster 生成。 
109B>Make Hierarchy 
   選ばれた Partition による Hierarchy 生成。 
110B>Make Vector 
   選ばれた Partition による Vector 生成。 
111B>Coun,Min/Max vector 
    以下の情報 
    ①クラスターの頻度 
    ②Partition によって与えられた最大、最小の Vector の値 
 

16B3.6Pertitions 
  2 つの Partition ファイルの処理。 

 
112B>Extract secound from first 
  Second box で決定された基準（特定の数値間）を満たす First box の頂点を引き出す。

この処理は、実際に頂点について様々な情報が保存された Partiton を持っているとき

役立つ。（例：ジェンダー=性の情報を持つ Partition）幾つかの最短パスを持つとき（例

えば、選ばれた頂点から 3 パス以内の距離の頂点）、ジェンダーの情報は、Partition
上の処理を実行することなしに失う。 

113B>Add partitions 
  2 つの Partiotn を追加する。（例えば、非環上ネットワークの Input と Output の近隣

が結合しているときに役立つ。） 
114B>Fuse Partitions 
  2つのPartitionを融合させる。First boxの partitionの後ろにSecond boxの partitioin

をつなげる。 
115B>Expand 
  より高い（元の）定義数の Partition を上昇させる。 

First Box 

Second Box 

Third Box 

各 Partition ボックスを以上の

ように名づける。 

図：Partition ボックス 
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<First according to secound(Shrink) 
 First box の Partition を、Second box の Partition が縮小していくものにした

がって上昇させる。 
<Insert First into Secound according to Third(Extract) 
 現在の Partition は、First box から Second box に定義された選択されたクラス

を引き出すことによって得られる。この Sub-Patition（部分 Paritiion）は修正

されたものである。この処理を使用するとき、この修正された Sub-Paritiion を

Firist box の Patitiion の後ろに挿入することが出来る。 
116B>Intersection 
  2 つの Partition を交差させる。 
117B>Make Random Network 
  以下のランダムネットワークを生成する。 
   1)入次数の定義は First partition のデータに従う 
   2)出次数の定義は Second partition のデータに従う 

118B>Info 
    2 partition の情報を表示する。 

<Cramer's V,Rajski 
 Cramer's V,Rajski 係数を計算し、レポートする。 
<Spearman Rank 
 相関係数 

 
 

17B3.7Vector 
Vector：ベクトル 
ベクトルを使った作業を行うためのメニューである。ただし、Vector は有向線でなく、

このデータ構造は、頂点半径にフィードバックされることに注意する。つまり、ベクト

ルの値が大きいほど頂点の半径が大きくなる。また、ベクトルの値は頂点によって属性

とされている値である。これは、以下のように考えられる。頂点の持つベクトルの値は、

頂点に入ってくるベクトルの量であり、ベクトルの量（入ってくるベクトルの多さ）が

大きいほど入ってくるものが多いため頂点が大きくなる。 
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 出て行くベクトルは無関係であることに注意 
また、“無向線（edge）でもこの値は成立する。” 

 
 入ってくるベクトルは、 
 
 注意点：Vector は上記のようにきれいに決定するものでなく、Vector が頂点に入って

いく量を無視して“独立に決定することが多い”。1 つしか入っていないのに

値が大きく、たくさん入っているのに値が小さいこともある。 

図：頂点 A ベクトルの値に対する概念図 
  頂点 A に入ってくるベクトル数は、2 であるため頂点 A のベクトル値は 2 である。

図：入ベクトルが多くなると頂点の視覚化半径が大きくなる 
この大きさは各頂点が持っているベクトル量が半径にフィードバックされた結果で

ある 
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 もともと、これらの概念は抽象的であり、対象とする実ネットワークの意味からこれ

の解釈を考える。ある地域の交通網ネットワークを解析したのなら、そのネットワー

クの入ってくるベクトル（道路）が小さいのに頂点（交差点）ベクトル量が大きいな

ら、その頂点に入るベクトルは交通量が膨大な道路であるという解釈が出来る。 
119B>Create Identity vector 

Dimention of Vector を入力する。 
値１の Vertex が入力した値だけベクトルファイルに生成される 

120B>Extract Subvector 
Partition ファイルが存在しないとエラー発生する。 
基準は選んだパーティションの種類。 
サブベクトルをベクトルから引き抜く。 

121B>shrink vector 
ベクトルの値が減少する。 

122B>Make Partition 
Partiiton に Vector をコンバートする。 

<by Intervals 
適当なクラス番号をとった選ばれた分かれている等しいベクトル頂点と値は、

適当なクラス番号を取る。 
間隔は取る（削除する）ことが出来る。 
*First Threshold and Step 
*Selected Thresholds 

図：入ってくるベクトルと関係なく大きくなる頂点の視覚化半径（ベクトル

量） 
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<by Truncating(Abs) 
123B>Make Permutation 
  Vector から Parmutation を作成する。 
124B>Transform 
  Vector ファイルを変形させる。 

<Multiply by 
  連続的に加算する。 
<Add Constant 
  Vector の値を連続的に加える。 
<Absolute 
  値の絶対値をとる。 
<Absolute+Sqrt 
  2 乗根の絶対要素 
<Truncate 
  Vector の値の切捨て 
<Exp 
  Vector の値の指数 
<Ln 
  Vector の値の自然対数。 
<Power 
  Vetor の値のべき乗 
<Normalize 
  Vector の値の標準化 

*Sum 
 合計値を 1 とする標準化 
*Max 

      最大値を 1 とする標準化 
 

18B3.8Vectors 
2 つのネットワーク（２つの*.net ファイル）の vector 処理に関するメニュー 
125B>Add Vectors 

2 つの Vector ファイルを一緒にする 
126B>Subtract Second from First 
  First から Second を引く 

Difference of selected vectors 
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127B>Multiply Vectors 
  Vectors を増やす。 

product of selected vectors 
128B>Divide First by Second 
  2 つの vector ファイルを分配（分類）する。 
129B>Linear Regression 
  2 つの Vector ファイルを線形回帰にフィットさせる。 
130B>Min(V1,V2) 
  選ばれた Vector の少ない要素。構成は、Min(V1,V2)。 
131B>Max(V1,V2) 
  選ばれた Vector の大きい要素。構成は、Max(V1,V2)。 
132B>Fuse Vectors 
  2 つの Vector ファイルを融合する 
133B>Transform 

2 つの Vector を他の２つの Vector へ変形する。 
<Cartesian->polar 
直交座標から極座標 

<polar->Cartesian 
極座標から直交座標 

134B>Info 
 

19B3.9Permutation 
Permutation：順序の変更, 交換; 【数】順列; 
ネットワークにおける Permutation とは、そのネットワークの頂点を入れ替える

（renumbering）することである。 
頂点を入れ替えるとは、頂点番号（ノード番号）を入れ替える。いままである頂点のあ

ったところに別の頂点との入れ替えが起こる。 
 
 

 
メインスクリーンの Permutation メニューに*.per ファイルが生成される。 
*per ファイルのデータ構造は、 
*Vertices ノード数 
１~n のノード番号（n 行１列） 
となっている。 
*.net ファイルの Vertices データ部分のノード番号を変更するためのものである。 
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メインスクリーン上の Edit ボタンを押すと、Edit サブテーブルが 
『ノード番号 新ノード番号-新ノード番号』 
という形で表示される。 
ダブルクリックでノード番号が変更可能。 

 

元の頂点番号 

変更頂点番号 

変更先頂点番号のラ

ベル（つまり変更され

るラベル）  

図：Permutation の Edit メニューの解説 

右クリックで、変

更先頂点番号を変

更することが出来

る。 
例:52→30 
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*Vertices 327 
89 
172 
165 
302 
82 
70 
131 
33 
257 
177 
52 
226 
189 
203 

図：上図 per ファイルのテキストエディタでの表示と Edit との比較 

対応 

*Vertices     327 
1 "N"  0.7113    0.6624    0.4185
2 "C"  0.7087    0.6075    0.4422 
 
(中略) 
 
*Edges 
       1        2 1  
       2        3 1  
       2        5 1  
       3        4 1               

頂点の再配置が行われ

ても、

ラインはそのままで

ある。

つまり、ネットワークのある頂点の

位置に再配置先の頂点がすべてのデ

ータをもって再配置される。 

図：*.net ファイルと再配置 
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１ 

2 

3 

“Tanaka” 
3  4  

“kikuchi” 
4  6  

“yamada” 
4  5  

再配置 
1→2 
2→3 
3→1 

１ 

“Tanaka” 
3  4  

2 

“kikuchi” 
4  6  

3 

“yamada” 
4  5  

座 標 を 反

映すると ラインはまったくいじらない

が、頂点のすべての情報を入

れ替える（座標情報も） 

１

“Tanaka” 
3  4  

3 

2 

“kikuchi” 
4  6  

“yamada” 
4  5  

つまり、処理としては頂点の再配

置であるが、やっていることはラ

インの張替えである(Rewire) 

図：Permutainon で行っていること 
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*.per ファイルを生成する際に、Demention（*.per ファイルに写したい頂点番号の範囲）

を指定する。対象*.net ファイルの頂点数より少ない値を指定すると、指定した頂点番号ま

でを、*.Per ファイルへ書き込み、それ以外の頂点は無視される。 
このときの*.per ファイルの構成 
『ノード番号. 新ノード番号』 
となる。 

 
135B>Identity 

*.net の*Verics の頂点番号と同一の頂点番号の*.per ファイルが生成される。 
136B>Random 

*.net ファイルの頂点番号をランダムに並び替えた頂点番号が*.per ファイルに書かれ

る。 
137B>Random 2-mode 

2-Mode（２部グラフ）ネットワークの頂点番号を頂点数を Deimenton（定義）された

だけ、ランダムに並び替えた*.per ファイルが生成される。 
138B>Inverse 

逆順=Inverse にする 
それは下記>Mirror で実現できる 
Inverse： 
データ構造に変化なし 
どのような意味があるのか 

頂点番号 次数 

1 2 

2 1 

3 1 

頂点番号 次数 

3 2 

1 1 

2 1 

頂点番号 次数 

1 1 

2 1 

3 2 

頂点の再配置 整理（並び替え）

相対的にライン

の張替えである

ことがわかる。 

図：上図の次数に注目したもの 
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139B>Mirror 
鏡に映したように、逆順に並び替えた(sort)*.per のデータ構造となる。 

 
140B>Make Partition 

 
入力項目 
①Number of Cluster と聞いてくる 

（Between 頂点番号 1 and 頂点番号最大値と入力値が制限される） 
どの数だけクラスターを作るかということ 

Permutation のデータ構造に変化はない。だが、Partition メニューに*.cls ファイルの

生成される。 

*Vertices 327 
319 
133 
326 
56 
（中略） 
40 
180 
26 
173 
 

*Vertices 327 
173 
26 
180 
40 
（中略） 
56 
326 
133 
319 

Mirror 

図：Mirror 
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つまり、Permutation（*per）のデータ番号（頂点再配置）から Partition(*cls)のクラ

ス番号を生成する。 

 

 

クラスター数

を頂点番号と

同じにした 

Partition Permutation 

図：Make Partition 
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クラスター数

を頂点番号と

違う 3 とした 

Partition Permutation 

図：Make Partition 

User が任意の 
クラスター数を入力 

仮想的な再配置による

ネットワーク生成

ファイル

が生成さ

れない。 

この生成されたネットワー

クをクラスター番号で

Partition 化 

Parititon ファイ

ル(*.cls) 生成 

図：Make partition の処理手順 

Parmutation ファ

イル(*.per) 
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141B>Make Vector 
*.per のデータがそのまま*.vec となる。データ構造は.per と同様なので、拡張子が変

わるだけとも取れる。 

 

 

20B3.10Cluster 
メインメニューの Cluster ボックスに*.cls を生成する。 
142B>Create Empty Cluster 
  何の情報もないクラスターを生成する。Edit で手動かつ自由にクラスターを形成する

ためのファイル。 

*Vertices 327 
287 
294 
193 
185 
37 
315 
227 
141 

*Vertices 327 
287 
294 
193 
185 
37 
315 
227 
141 

Parmutation Vector 

Make Vector 

*.per *.clu 頂点の再配置

番号（ラインの

張替え） 

頂点の大きさ 

図：Make Vector 
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図：Empty Cluster ファイルの頂点追加 

ここをクリックして、

頂点を入力し、手動で

クラスターを作る。 

Edit をクリックし

て生成されるウイ

ンドウ 

 

Empty Cluster 

*.cls 

Cluster の追加 

クラスターの形成 

各種クラスター

の処理 

図：Empty Cluster 
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Pertition ファイルと Edit ウインドウが同じ構成だが、意味がまったく違うことに注意する。 

クラスターの整理番号 

クラスターに所属してい

る頂点情報 
（頂点番号―ラベル） 

図：cluster ボックス Edit によるウインドウの説明 

       1 
       3 
       4 

Edit 

*.clu 
ファイル 
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143B>Create Complete Cluster 
   入力された定義数に従い、.net ファイルから定義数だけの頂点番号の頂点を、クラ

スター化する。 
     入力項目 
      ①定義数（どれだけの量の頂点をクラスター化するか）  

Permutation 番号

クラスターに所属してい

る頂点情報 
（頂点番号―ラベル） 

図：*.per と Permutation ボックス Edit によるウインドウの説明 

 *Vertices 327 
20 
185 
193 
163 
219

Edit 

*.per 
ファイル 

この番号は、

この番号と等

しい頂点番号

と、右側の頂

点とを入れ替

える目的のも

ので、入れ替

え対象の頂点

番号といって

いい。 
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144B>Make Partition 
クラスターをパーティションに変形する。 

  Partition の定義数を入力する際に、対象の,net ファイルの頂点数と同じ数でないと、

可視化できないことに注意。 
  手順 

①*.net の頂点数と同じ数の Partition 定義数を入力。 
②クラスターに属している頂点をクラス番号 1 になる。 
③クラスターに属していない頂点をクラス番号 0 になる。 
④可視化したときに、色別でクラスターとクラスターでないものがわかる。 

 

（中略） 

定義数から数え

て、元のネットワ

ークの頂点数と

同じクラスター 

頂点を追加・削除

してクラスターを

整える。 

図：Create Complete Cluster 

クラスター化

された元ネッ

トワーク 

クラスタ

ーに属す

頂点

クラスタ

ーに属さ

ない頂点

クラス番号 0 

クラス番号 1 

元ネットワ

ー ク の う

ち、クラス

ターに属し

ている頂点

と属してい

ない頂点が

Parition の

色分けで可

視 化 で き

る。 

図：Make Partition 
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図：35 の Complete cluster の Partition 化による可視化 

    頂点番号 1~35（Complete cluster）がそれに属していないも頂点と別の色（つま

り別のクラス番号）となっていることがわかる。 
145B>Binarize Partition 
  上記と同様に、クラス番号を 0 か 1 にした Cluster の Partition。Cluster と Partition

が必要。 
 

21B3.11Hierarchy 
このメニューは、すべて Hierarchy ファイル（*.hie）を使用し処理する。つまり、Hierarchy
ファイル（*.hie）がないと処理できない。 

146B>Extract Cluster 
 Hierarchy から cluster を引き出す。 

147B>Make Network 
 Hierarchy から Network を作成する。 

148B>Make Partition 
 Hierarhy から Partition を作成する。 

149B>Make Permutation 
 Hierarchy から Permutation を作成する。 
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22B3.12Options 
 

150B>Read/Write 
   以下の設定を行うためのコマンド。 

 
図：Options>Read/Write の設定画面 

<Threshold 
Threshold：しきい値 
与えられた 2 頂点間の Generate line よりも高い（絶対に）ラインの値 

<Max.vrtices to draw 
ネットワークで最大値をもつ頂点に従った視覚化。 

<Read/Save vertices labels? 
 頂点のラベル、座標、その他の描写に関わることを読み込むか読み込まないか

の指定。大規模なネットワーク・ラベルの長さが長い場合、これらが読み込も

うとすると、これらの読み込み処理が非常に遅くなってしまう。読み込み処理

の速度の遅延を防ぐためにこの設定をはずすことが可能である。 
  
 また、ある.Net ファイルの頂点のラベルを、別の.Net ファイルの頂点のラベル

から上書きすることも可能である。 
  Net>Transform>Add>Vertex Labels form File 
<Save coordinates of vertices? 
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頂点座標を、読み込みするかしないかの設定。 
<Save complete vertex description? 
完全な頂点の描写（例：形、時間、間隔など）を読み込むかしないかの設定。 

<Check equality of vertex descriptions by reading? 
 大規模ネットワークの可視化の処理速度向上のために、頂点の描写を変える。 
 チェックする：空間を同じ頂点の描写ときも、しばしば繰り返して読み込む。（例、

頂点の形） 
 チェックしない：時間を読み込むときそれらの描写が違うとき、時間を読み込

む。（例、現ネットワークのタイムスタンプ） 
<Check equality of line descriptions by reading? 
 大規模ネットワークの可視化の処理速度向上のために、ラインの描写を変える。 
 チェックする：空間を同じラインの描写ときも、しばしば繰り返して読み込む。 
        （例、点線か実線かのパターン） 
 チェックしない：時間を読み込むときそれらの描写が違うとき、時間を読み込

む。（例、現ネットワークのタイムスタンプ） 
<Auto Report? 
テキスト形式のレポートを rep1.rep ファイルに自動で書き込む 

<ore:1-Male,2-Female links 
Ore グラフという系図を読み込んだとき、2 種類の異なった有向グラフが生成さ

れる。 
1 の値を持つ有向線は、父から子へという関係を持つ。 
2 の値を持つ有向線は、母から子へという関係を持つ。 

<GEDCOM-Pgraph 
     系図を読み込むとき、pgraph のフォーマットを使う（ノードはカップルか個人

的か） 
<Bipartite Pgraph 

     個人的なマリッジ、トライアングル、サークルというスクエアを持つ、2 部 p グ

ラフを生成する。 
<Pgraph+labels 

     GEDCOM ファイルを読み込んだとき、pgraph のラインのラベルもまた取り付

ける。 
<x/0 

   0 と 0 でないものを分離したとき結果を指定する。 
<0/0 
 0 と 0 を分離したとき結果を指定する。 
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151B>Blockmodel 
  縮小されたブロックモデルの型を選ぶ。 
 
152B>Ini file 
 *.ini：pajek の構成が保存されているファイル。 
    Option で設定された変更点を保存する。 

<Load 
*.ini ファイルを読み込む。 

<Save 
*.ini ファイルを書き込む。 

153B>Fontsize 
 フォントサイズを変更する。 

 

23B3.13Info 
読み込まれた各種ファイルの情報（Information）を表示する。 
Edit で情報を表示することとの違いは？ 

154B>Network 
ネットワークに関する情報（*.net ファイルのデータ）の表示。 

<General 
*number of vertices 

  頂点数を表示する。 
*number of arcs,edges and loops 

  有向線、無向線、ループの数を表示する。 
*density of lines 
ライン（Edge、Arce）の濃度を表示する。 

*sort lines according to their values (ascending or decending)to find the 
most/least important lines 

<Line Values 
<Indices 

Indices=? 
<Triadic Census 

Triad：3 ノード間のラインの状態 
Triads：Triad の種類をすべて（16 種類）集めたもの 
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図：Trads[manu] 

Triads の記号 
『タイプ番号－3 つの番号』 

     3 つの番号の意味は、 
      『（有向線が張られていない間隔数）（有向線の数）（両向有向線の数）』 

同じ 3 つの番号で別の種類の Tiads は、最後にアルファベットの記号を付ける。 
処理すれば、Vectors メニューにファイルに以下の 2 つの*.vec が生成される。 
この vector ファイルで可視化することは出来ない。なぜなら、データ数は必ず

16 であり、ネットワークサイズと合わないし、可視化を前提にしていない。 
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Triadic Census 

Traiadic Census 
(データ数 16) *.vec 

Expected  
Tradic Ccensus 
(データ数 16)*.vec 

テキストファイル

として保存・処理 
R・SPSS によって

統計処理 

グラフ統計など 

図：Triadic Census の処理過程 
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Vertex と書かれているが、 
Traiadic の種類番号である。 

Val と書かれているが、 
Traiadic の種類番号に対応す

る Traiadic の予測数である。

図：Expected Traiadic Census 

 

図：Traiadic Census 

Vertex と書かれているが、 
Traiadic の種類番号である。 

Val と書かれているが、 
Traiadic の種類番号に対応

する Traiadic の数である。 
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図：Report 

 
<Multiple Relations 

       以下のネットワークの要素に関する Report を出す。 

 
図：Multiple Relations の Report 

<Vertex Label->Vertex Number 
頂点を指定、あるいはラベルを指定する。 
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入力された値に従い、頂点とラベルの情報がサブウインドウ上に表示される。 
>Perrition 
   

 

Highest/Lowest or interval of values 
Input 1 or 2 numbers:+/highest,-/lowest 

(+、－と数字で入力する。) 

Minmum frequency to show 
Select mimunum frequency 

Report のラン

ク数になる。 

表示する最小

確率を入力 

Report 

*clu 

図：info Perrition の処理過程 
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155B>Hierarchy 

Hierarchy に関する情報を生成する。 
156B>Vector 

Vector に関する情報を生成する。 
  サブウインドウでの表示 
157B>Memory 

使用マシンのメモリに関する情報。 
158B>About 

Pajek の Copyright や Version に関する情報。 
 

24B3.14Tools 
159B>R 

<Send to R 
<Locate R 

160B>SPSS 
<Send to SPSS 
<Locate SPSS 

Pakek のフォルダに、SPSS のシンタックスファイルとして書き込まれる 

最大クラスター（サブ

グラフ）の頂点ランク

の表示 

クラスター1 つ 1 つに

関する情報 

ネットワークの 
基本情報 

図：info partition の Report 
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161B>Web Browser 
Vertex をシフトか右クリックをすると web ブラウザーが開かれる 

162B>Add Program 
ツールメニューに特別なプログラムを実行する項目を追加する 

163B>Edit Parameters 
追加された項目のプログラムをエディトする 

164B>Remove Program 
追加された項目を消す 

 

25B3.15Draw 
  ・*.net 

・*.cls 
・*.vec（2 つを使用する場合もあり） 
の 3 つのファイルを適宜利用して可視化する 

165B>Draw 
 *.net を可視化することが出来る。 

166B>Draw-Partition 
 Partition(*.cls)ファイルに従った、頂点がどのクラスに属しているかを、クラスごとに

色分けして可視化できる。 
167B>Draw-Vector 
 Vector(*.vec)ファイルに従った、頂点の大きさを*.vec の値に反映させて可視化できる。 
 ネットワーク(*.net)の頂点数と*.vec の定義数が等しくなければならない。 

 

図：Bitweenness 中心性を計算した Vector ファイルを反映した可視化の例 
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中心性の高い値ほど頂点が大きくなっていることがわかる。 
168B>Draw-2Vectors 
 2 つの Vector(*.vec)ファイルに従った、頂点の大きさを*.vec の値に反映させて可視化

できる。 
 メインスクリーンの Vector ボックスの 1 番目に入っている*.vec は頂点の幅になり、 
 2 番目に入っている*.vec は頂点の高さになる。 
 

 
 上図の場合は、2.All closeness centrality in N1(327)のデータが、頂点の幅、 
１.Betweenness centrality in N1(327)が頂点の高さとして頂点のサイズが変更される。 

169B>Draw-Partition-Vector 
 Partition のクラスごとの色分けと、Vectoe の頂点サイズの変更を同時に行う。 

170B>Draw-Partition-2Vectors 
 Partition のクラスごとの色分けと、2 つファイルの Vectoe の頂点サイズの変更を同時

に行う。 
171B>Draw-SelectAll 
 Null-Partition を使ったネットワークを可視化する。 

 
 

3B4.Drawウインドウツールバー上の各種メニュー 
26B4.1Layout 
172B>Circular 

円状に頂点を配置する。 
1.Original 
普通の円状の配置 
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2.Using Permutation 
Permutation を反映した円状の配置 

 

図 Randam permutation による可視化 
3.Using Partition 
Partition によって、クラスター毎に分離する円状の配置 
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図：次数による Partition の可視化 
4.Randam 
頂点を円状ランダムの配置する 
 

173B>Energy 
 自動的にネットワークのレイアウトを生成する。 
1.Kamada-kawai 
 頂点の配置の自動レイアウトのためのアルゴリズム 
 
 

 
図：座標を反映した配置 

 
図：同じネットワークで、Kamada-kawai アルゴリズムで最適化した可視化 

(a)Free 
 配置可能なすべての位置 
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(b)Fix first and last 
最初から最後までの頂点が画面の角に一致するように 

(c)Fix one Vertex in the middle 
選んだ頂点が中心（Middle)に来るように 

(d) Selected group only 
    Partition から選んだ頂点のみ 

(e) Fix Selected Vertices 
 選んだ頂点に合うように 

partition(.clu)を読み込んだ視覚化のみメニューに出てくる 
2.Fruchterman Reingold 

Kamada-kawai 以外の自動レイアウトのためのアルゴリズム 
(a)2D 

Optimization： 
2 次元空間（Plene）に置く 

 

球状に配置されている。Spin してみるとわかる。 
Spin>Spin around>スピンしたい角度 
あるいは、ScrollBar を表示して回転させる。 
Option>ScrollBar On/Off 

(b)3D 
3 次元空間（Spece）に置く 
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 (c)Factor 
 Fruchterman Reingold 最適化(optimization)を使っているとき、頂点間の最適な距

離のための要素の入力 
3.Srarting Positions 
  エネルギー描写（energy drawing）のための初期配置 
 

174B>Eigen values 
Lanczos アルゴリズム 
Eigen-=固有の 
固有値、固有ベクトルを用いた描写（Lanczos アルゴリズム） 
ラインの値を計算するかしないかもできる？ 
1.111 

2つか3つの固有値を選ぶとアルゴリズムは符合している固有ベクトルと計算される 
(a)111 
はじめに符合した固有値の 3 つの固有ベクトルを計算する 

(b)112 
はじめに符合した固有値と 2 番目に符合された 1 の２つの固有ベクトルを計算 

(c)122 
 はじめに符合した固有値と 2 番目に一致する 2 の 1 つの固有ベクトルを計算 
(d)123 
 はじめに一致した固有ベクトル、2 番目に一致した 1 と 3 番目の固有値に一致した

１を計算する。 
(e)11 
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 2 つのはじめの固有値に一致した固有ベクトルを計算する。（2 次元描写） 
 

27B4.2Layers 
pertition(.clu)を読み込んだ視覚化のみメニューに出てくる。 
175B>Type of Layout 

2D か 3D のいずれの表示にするかを決定する。 
2D－x,y 
3D－ｚ 

176B>In y direction 

 
177B>In y direction+random in X 
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178B>In Z direction 

 

立体状に配置されている。Spin してみるとわかる。 
Spin>Spin around>スピンしたい角度 
あるいは、ScrollBar を表示して回転させる。 
Option>ScrollBar On/Off 

179B>In Z direction+randam in xy 
  Z 方向へ、x とｙをランダムにして表示する。 
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180B>Averaging x coordinate 
181B>Averaging x and y coordinates 
182B>Tile in x direction 
183B>Tile in xy plane 
184B>Optimize layers in x direction 
185B>Optimize layers in xy plane 
186B>Resoluttion 
 

28B4.3GraphOnly 
ラベルやアローを取り除いた可視化ネットワークを表示する。 
 

29B4.4Previous 
 前に表示した可視化ネットワークを表示する。 
 

30B4.5Redraw 
 可視化ネットワークを再描写する。 
 

31B4.6Next 
 前に表示した可視化ネットワークを表示した後、次の前に表示した可視化ネットワーク

に戻り表示したいとき。 
 

32B4.7Options 
187B>Transform 
   可視化を変化させる。 

1.Fit area 
(a)max(x),max(y),max(z) 
  可視化の大きさを x,y,z でフィットさせる。 
(b)max(x,y,z) 
   実際の形を整えつつ、可視化エリアをフィットさせるように再調整する。 

2.Resize 
 選ばれた要素（x,y,z）の 3 方向すべてへ可視化を再調整する。 
  入力項目 
   ①Resize factor in x direction 
      ②Resize factor in y direction 
   ③Resize factor in z direction 
3.Translate 
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 可視化を空間上で変形（移動）させる。 
①Translate factor in x direction 

      ②Translate factor in y direction 
   ③Translate factor in z direction 
4.Reflect y axis 
  y 軸で可視化を反射させる。 
5.Rotate 2D 
  x,y 平面上で、指定された角度で回転させる。 
6.Fisheye 
  可視化を、フィッシュアイ上に変形させる。 
  *Cartesian 
    直交（デカルト）座標上のフィッシュアイ 
    入力項目 
     ①amount of movement 
             (「どれだけ動かすか？」で、値が大きいほど端に大きく寄る) 

 
図：amount of movement：3 の Fisheye *Cartesian の例 
 
 *Polar 
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 極座標上のフィッシュアイ 
入力項目 

     ①amount of movement 
             (「どれだけ動かすか？」で、値が大きいほど端に大きく寄る) 

 
図：amount of movement：3 の*Polar Fisheye の例 

188B>Valies of lines 
 
189B>Mark vertices using 
 ラベルやクラスの番号などを可視化したり、可視化を消去したりする。 

１、Labels(ctrl+L) 
ラベルを可視化する。 

２、Numbers(ctrs+N) 
頂点番号を可視化する。 

３、Partition Cluster 
Partition（クラス番号）を可視化する。 

４、Vector Values 
   Vector の値（頂点の大きさ）を可視化する。 
５、No Labels(ctrl+D) 
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   ラベルを表示しない。または、消す。 
６、No Labels No Arrows 
   有向線の向きの矢印とラベルを消去する。 
７、Mark Cluster Only 

     現在クラスターに属している頂点のみ、ラベルを可視化する。 
190B>Lines 
  ラインの可視化についてのメニュー 

1.Draw Lines 
(a)Edges 
 無向線（Edges）を表示するかしないかのチェック。 
(b)Arcs 
 有向線（Arcs）を表示するかしないかのチェック。 
(c)Relations 
 選んだ関係番号のラインのみ表す。 
関係番号：*.net ファイルの*Arcs、*Edges のライン定義の部分の上から、関

係番号 1,2,3･･･と自動的に付けられていく番号。*.net では、ユー

ザーは入力したり、指定することはない。 

 
    補足：関係番号 1 の行の意味は、頂点 1 から 2 へラインの値（重さ）

1 でつなげるという意味。 
2.Mark Lines 
 ラインのラベルや値の可視化。 

(a)No 
(b)with Labels 
 ラインのラベルを可視化する。 

*Arcs 
       1        2 1        

2        3 1  
       2        5 1  
       3        4 1  
       3        8 1 

1 
2 
3 
4 
5 

関係番号 

図：*.net ファイルと関係番号 



 176

(c)with Values 
 ラインの値（重さ）を可視化する。 

3.Different Widths 
  これをチェックすると、ラインの横幅がそのラインの値（重さ）に応じた幅

になる。 

 

 
図：ラインの値（重み）をラインの幅で反映した可視化 

 

*Arcs 
       1        2 1       

2        3 2 
       2        5 3 
       3        4 1  
       3        8 1 

図：ラインの値（重み）とそのラインの幅での可視化 

Different Widths
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4.GreyScale 
 これをチェックすると、ラインがラインの値（重み）にしたがって、黒くなる。 
 重みが少ない順から白→灰色→黒と灰色のスケール（GreyScale）になって可視

化される。 

 

 
図：ラインの値（重み）を灰色のスケールで反映した可視化 

      補足：ラインの値（重み）が最小のものは、白で可視化され見えていない。 
 

*Arcs 
       1        2 1       

2        3 2 
       2        5 3 
       3        4 1  
       3        8 1 

図：ラインの値（重み）とその灰色のスケールでの可視化 

Different Widths
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Different Widths と GreyScale は両立でき、両方チェックすると以下のよ

うに、ライン幅とグレースケールでラインの重みを可視化する。 

 
     図：ラインの値（重み）を灰色のスケールで反映した可視化 
 

191B>Size 
    以下のものの可視化サイズを変更する。 
    <of vertices 
      頂点の大きさのサイズ変更。 
       入力項目 
       ①頂点の大きさ（0 は auto） 
        <of vertices defined in input file 
      *.net ファイルの頂点の大きさの設定に従い頂点の大きさを変える。 

x_fact x 軸方向に何倍拡大するか x_fact 3：x 方向に 3 倍拡大 

大きさの設定 y_fact y 軸方向に何倍拡大するか x_fact 5：y 方向に 5 倍拡大 

        表：*.net の頂点の大きさ設定 
      ただし、Vector の大きさが入るとわかりにくくなる。 
        <of vertitces Border 
      頂点の枠の横幅のサイズ変更。 



 179

入力項目 
       ①頂点の枠の横幅 
        <of Lines 
       ラインの横幅のサイズ変更。 
        <of Arrows 
       矢印のサイズ変更。 
        <of Font 
       フォントサイズの変更。 
        <Default 
       デフォルト設定へ戻す。 
192B>Colors 
    <Back Ground 
              可視化ウインドウのバックグラウンドの色の変更。 
        <Vertices 
       頂点の色の変更。 
        <Vertices Border 
       頂点の枠の色の変更。 
        <Edges 
       無向線の色の変更。 
        <Arcs 
       有向線の色の変更。 
        <Font 
       フォントの色の変更。 
        <Partition Colors 

Partition の色設定を変更する。クラス番号に従い、可視化のときの色分け         

がなされるが、そのクラス番号と色の対応を設定できる。 
        <Relation Colors 
       Relation の色設定を変更する。 
        <Default 
       デフォルト設定に戻す。 
 
193B>Layout 

1.Redraw during moving 
2.Real xy proportions 
3.Arrows in the Middle 
4.Size of vertex 0 
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(a)Hide vertex 
(b)Hide attached lines 

5.Decimal Places 
6.Show SubLabel 

194B>ScrollBer On/Off 
 ScrollBar を ON/OFF（出したり閉まったり）する。 
  ScrollBar：可視化されたネットワーク 3 次元的を回転させるためのバー 

 

195B>Interrupt 
 Interrupt：さえぎる; 妨げる; 中断する;割り込む(む), 中断（する）;インタラプト 

196B>Previous/Next 
1.Max number 
2.Seconds to wait 
3.Optimaize Layouts 

(a)kamada-kawai 
(b)2DFrucht.Rein 
(c)3DFrucht.Rein 
(d)No 

4.Apply to 
(a)Network 
(b)Partition 
(c)Vector 

197B>Select all 
 

ScrollBar 

Draw Window 

図：ScrollBer 
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33B4.8Export 
 可視化されたネットワークを各種画像ファイルに送る。 
198B>EPS/PS 
 EPS フォーマットに送る。 
 WYSIWYG：What You See Is What You Get(見たものは取得したもの) 
 クリップか WYSIWYG を入れるか入れないか 
 Partition によって定義づけられた、色あるいは白黒の可視化ネットワークが EPS ファ

イルデータとなる。 
 PS フォーマットに送る。 
 PS：Program stream 

  MPEG-2 システムにおけるプログラムストリーム。 
199B>SVG 
 SVG：Scalable Vector Graphics 

          XML によって記述されたベクターグラフィック言語のこと、或いは、SVG で記

述された画像フォーマットのこと。 
          SVG（XML によって記述されたベクターグラフィック言語）や HTML 内で使

用することが出来る。 
1.General 
2.Labels/Arcs/Edges 
3.Partition 

(a)Classes 
(b)Classes with semi-lines 
(c)Nested Classes 

4.Line Values 
(a)Classes 
(b)Nested Classes 

(c-1)Options 
(c-2)Different Colors 
(c-3)Using GreyScale 
(c-4)Different Widths 

5.Multiple Relations Network 
6.Current and all Subsequent 

Subsequent： 
200B>VRML 
 VRML：Virtual Reality 

          3 次元の物体に関する情報を記述するためのファイルフォーマット。WWW 上
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で利用されることを前提に設計された。 
201B>MDL MOL file 

  MDL MOL file：MOD Molfile format 
  HUhttp://www.mdli.comUH  (Chemscape Chime). 

202B>Kinemages 
  Kinemages format： 

1.Current Network Only 
2,Current and all Subsequent 
3,Multiple Relations Network 

203B>Bitmap 
 Bitmap：windows の画像ファイル形式 

204B>Options 
 EPS、SVG、VRML の初期設定のオプション 

 

34B4.9Spin 
205B>Spin around 
 角度を指定して可視化ネットワークを回転させる。 

206B>Perspective 
 Perspective：遠近［透視］画法; 透視画; 遠景; 見通し, 展望; 正しい見方, 観点; 釣合

い. 
 頂点間の距離を小さく（あるいは、なく）可視化する。 

207B>Normal 
 標準頂点（Nomal vector）を旋回させる（Spin around）。 

208B>Step in degrees 
 回転描写したときのステップ次数 
 Step in degrees： 

 

35B4.10Move 
209B>Fix 
 1．X 
 2．Y 
 3．Radius 
   Radius：半径 

210B>Grid 
 格子の位置を座標で指定すると、可視化画面に青い点が入る。この青い点を参考に、

頂点の座標を見ることができる。 
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211B>Circle 
 同心円の中心点の位置を座標で指定すると、可視化画面に青い点が同心円上に入る。

この青い点を参考に、中心点からの頂点の座標を見ることができる。 
212B>Grasp 
 追加された頂点を動かす。 

1.Closest Class Only 
2.Closest Class and Higher 
3.Closest Class and Lower 

 

36B4.11Info 
 以下の美的な特徴をの可視化を行う。 
 このときの頂点は、0 と 1 の間の値でないと処理できない。 
 レポートに Partition の方法が表示され、Partition ボックスに、*.clu ファイルが生成さ

れる。 
213B>Closest Vertices 
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214B>Smallest Angle 

 
215B>Shortest/Longest Line 
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216B>Number of crossings if lines 

 
217B>Vertex Closest to Line 
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218B>All properties 

 
 

 

図：All Propaties のレポート例 
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37B4.12 可視化画面自体処理 

219B頂点のクリック 
  1、頂点の右クリック 
     その頂点のリンク情報の一覧ウインドウが表示される。そのウインドウで、新

しいラインの追加を行うことが出来る。 

 
 ２、頂点の左クリック 
    頂点を左クリックしたまま、ドラッグするとその頂点を移動させることが出来る。 
 

220BParririon毎に可視化したときのParititionの移動 
 Parititon に左クリックをして移動させることが出来る。 
 

221B可視化の拡大 
  頂点のない箇所で右クリックして、拡大したいエリアを指定するとその可視化ネット

ワークを拡大することが出来る。「Redarw」コマンドで拡大を解除できる。 

選択した頂点のライン 
情報 

出頂点－入頂点 ラインの値 出頂点のラベル－入頂点のラベル 

新しいラインの追加 

図：可視化画面での頂点情報 
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図：右クリックによる範囲指定での可視化の拡大 
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